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Introductory Material



About TalkWorks

TalkWorks is the telephony program included with WinFax that enables you to use advanced telephone and 
answering machine features on your computer. Using TalkWorks, you can receive all your messages—both fax 
and voice—in one place.

Easier – TalkWorks installs a single-mailbox Answering Machine that is ready to use—start receiving 
messages right away. Access new messages from the Controller with one click. For more advanced setup, use the 
TalkWorks wizard.

Faster – Play new messages in any order. Listen to the message in the middle first, if you need to. Provide 
self-serve faxes for clients 24 hours a day with Fax On Demand.

Smarter – Keep records of incoming calls. Send and receive voice and fax calls using two modems and two 
phone lines. Or use one phone line, and let TalkWorks distinguish between voice, fax, and data calls.



About mailboxes

Depending on your call answering requirements, you can create as many mailboxes as you need. You can create 
the following types of mailboxes:

Voice Message mailbox – Plays a greeting, then records a voice message or receives a fax.
Announcement Only mailbox – Plays an “announcement” message and then hangs up (for example, “Our

office hours are ...”).
Fax On Demand mailbox – Allows you to set up a fax-back system, so callers can select documents they 

want faxed back to them.
Fax Only mailbox – Plays a greeting, then prepares to receive a fax.
Data Only mailbox – Hands the call over to a data communication program (for example, pcANYWHERE or

Microsoft RAS). This feature provides remote access to your computer, without the need for a dedicated phone line. 
(This mailbox type is not supported under Windows NT 3.51).

When callers leave voice messages in mailboxes, those messages are stored and saved on your computer as 
audio files in “wave” format (.WAV files). You can check for and listen to voice messages using the TalkWorks 
Answering Machine, the WinFax Logs window, or the Controller. If you want to retrieve messages from a remote 
touch tone phone, you can also set up mailboxes to allow password-protected remote access.



What’s new in this version 

If you are upgrading from a previous version of TalkWorks, the following list identifies the features that are new in 
this version.

Save time with the Controller – You can use the Controller to quickly start the Answering Machine or the 
Telephone, or to check for new messages and play them.

Log the traffic for mailboxes – You can now log all the calls that come into your mailboxes, whether or not 
callers leave messages. This can provide you with valuable information about how callers are using your system.

TalkWorks wizard is easier to use – Use the TalkWorks wizard to create a call answering system from 
scratch, modify your system, or create a new mailbox.

Dual line support – Both WinFax PRO 8.0 and TalkWorks 8.0 now support two phone lines. You can now 
set up two modems and use one on each line. How you configure each line depends entirely upon your call 
answering requirements and your modems.

Distinctive ring – TalkWorks now supports distinctive ring, a feature available from many phone companies.
If you subscribe to this service and your modem supports this feature, you can easily distinguish between voice and 
fax calls.

Save the settings for your call answering system – You can now save the settings and mailboxes you 
use for your call answering system as a “profile”. This feature allows you to quickly change your system by applying 
a profile you have previously saved.

Test your call answering system before you use it – You can now test your profile before you use it by 
running the TalkWorks Simulator, a new tool that allows you to experience your system just as a caller would, without 
having to dial in from another phone.

Mailboxes can have three-digit numbers – You can use up to three digits for mailbox numbers. This can 
make your office look larger than it is, an advantage for smaller companies.

New mailbox types –There are two new mailbox types that integrate voice calls with fax and data calls: Fax
Only and Data Only. Fax Only mailboxes allow you to set up a designated mailbox for faxes. Data Only mailboxes 
allow you to set up remote access to your computer, without having to set up a dedicated phone line. (These mailbox 
types are not available under Windows NT 3.51.)

Forward voice messages – If your system supports this feature, you can record a memo and send it via 
email to other Windows email users. In addition, you can now forward voice messages you receive to others using 
WinFax PRO (4.0 or later) as BFT attachments.



Most popular TalkWorks features

You can choose from a wide variety of powerful features in TalkWorks to customize your voice messaging and 
faxing needs. The table below highlights some of the most popular features in TalkWorks.

When you ... Did you know you can do this?

Keep a log of all 
phone calls

Now you can keep a log of the calls 
that come into each mailbox in your call 
answering system.

Save money—make 
the most of your 
phone lines

Make the most of the phone lines you
have.

Set up one line for receiving both faxes and 
voice messages (TalkWorks distinguishes 
between fax and voice calls).
Or, set up two lines and two modems: one 
line for faxes, the other for voice messages.

Set up a voice mail 
system and receive 
voice messages

Turn your computer into a basic 
answering machine.

Or, create multiple mailboxes to take 
voice messages, play announcements, and fax 
frequently requested information to callers.

Choose from prerecorded greetings 
or record your own. 

Handle all types 
of calls

You can create mailboxes that 
receive voice messages, faxes, and data calls.

Use the speaker 
phone feature

If your system supports the speaker 
phone feature, use the TalkWorks speaker 
phone for hands-free phone calls.

Use your Caller ID 
service

TalkWorks supports caller ID, a 
service offered by many phone companies. Use
caller ID to see who is calling you before you 
answer the TalkWorks Telephone.

Create a fax back 
system

Create Fax On Demand mailboxes 
that allow callers to select documents they want
faxed back to them.

Remote access Check for new messages and play 
messages from any touch tone phone.

Change your greetings and mailbox 
passwords too.



Programs included with TalkWorks

When you install TalkWorks (part of the WinFax installation), the Setup program creates and adds the WinFax 
PRO and TalkWorks family of programs to the Windows Programs menu. TalkWorks includes four programs:

Icon Program

TalkWorks Answering Machine – Use the TalkWorks Answering Machine to
receive and play voice messages, record memos, and change your greeting.
You can also play your voice messages from the WinFax Logs window.

TalkWorks Telephone – Use the TalkWorks Telephone to place voice calls 
using your computer or to answer voice calls using the speaker phone 
feature (if your modem supports speaker phone).

TalkWorks Simulator – Use the TalkWorks Simulator to test your call 
answering system before you start using it to receive calls.

TalkWorks AudioEditor – Use the TalkWorks AudioEditor to modify audio 
files for greetings or voice messages you have received.



Working in the WinFax Logs window

If you want to view and retrieve fax and voice messages from one place, use the WinFax Logs window to view 
new faxes and listen to voice messages. You can also search, sort, and delete voice messages from the Logs 
window.

To play back, edit and delete voice messages in WinFax, you can also use the AudioBar at the bottom of the Logs
window. 



About remote access

When you are away from your computer, you can retrieve voice messages and faxes from using any touch tone 
phone. You can also your greeting.

For security reasons, remote access is disabled for the default mailbox installed with TalkWorks. To enable remote
access, use the Mailbox wizard.



Planning Material 



About TalkWorks profiles

Together with a local voice-capable modem, TalkWorks turns your computer into a call answering system—either 
a basic answering machine or a multiple mailbox system. To customize how TalkWorks handles incoming faxes 
and voice calls, you can create one or more TalkWorks profiles. A profile is a collection of mailboxes and settings 
that determine how your TalkWorks call answering system works. You can create and save as many profiles as 
you need, and you can use them to quickly change your call answering setup. For example, you could create two 
profiles to handle calls differently during peak and off-peak business hours: the “peak” profile could direct calls to 
individual mailboxes; the “off-peak” profile could direct all calls to a single voice mailbox and play a message 
explaining the office is closed. For maximum flexibility, mailboxes can be shared by different profiles, so you do 
not need to create new mailboxes each time you create a profile. 

How do you want to use TalkWorks?

           I want to use TalkWorks as a basic answering machine (one mailbox for voice messages and faxes)  
           I want to use TalkWorks as a multiple mailbox system with different types of mailboxes  

 Related Topics



Planning TalkWorks profiles

Planning your call answering system before you create it will save you time, and may help you create a more 
functional and easy-to-use system. Before you create a profile, we recommend you consider some key design 
issues, such as the type of outgoing message you want callers to hear, the type of information you want to make 
available on your system, and how you want callers to access this information. Before you create a TalkWorks 
profile, do the following:

           Review the profile issues table below.  
               Plan your mailboxes.  
               Plan your greetings and menus.  
               Fill in the Planning Forms.  

Profile Design Issues

When you plan a profile, consider the following design issues: 

Profile feature Design considerations

Number of mailboxes

How many mailboxes do 
you want?

Do you want callers to leave messages in one 
mailbox, or do you want to offer a selection of 
mailboxes? For example, you could receive all 
messages in one mailbox or give each member
of your group a personal mailbox. Keep in mind
that using multiple mailboxes can make smaller
offices appear larger.

Mailbox types

What type of mailboxes do
you want to have?

There are five different types of mailboxes:
                 Voice Message mailbox     –     
TalkWorks plays the mailbox greeting, then 
records a voice message. This type of mailbox 
can also receive faxes, which allows you to 
receive all your faxes and voice messages in 
one mailbox.
                 Announcement Only mailbox     –     
TalkWorks plays an   “  announcement  ”   greeting,   
then hangs up. Callers cannot leave messages 
or send faxes.
                 Fax On Demand mailbox     –     
TalkWorks plays the mailbox greeting, then 
prompts the caller to select a document to be 
faxed back to them.
                 Fax Only mailbox     –   TalkWorks plays  
the mailbox greeting, then prepares to receive a
fax.
                 Data Only mailbox     –   When a caller   
selects this mailbox, TalkWorks hands the call 
over to a data communications program (such 
as pcANYWHERE or Microsoft RAS).

Main greeting

What do you want callers 
to hear first when 
TalkWorks answers the 
phone?

Single mailbox profile – If you create only one
mailbox, TalkWorks plays only one greeting.
Multiple mailbox profile – If you create 
multiple mailboxes, TalkWorks plays the main 
greeting, then plays the mailbox menu, if 
enabled (see below). Consider your mailbox 
menu when you plan your main greeting.

Mailbox menu
(multiple mailbox 
profiles only)

Do you want to use a 
mailbox menu, so that 
callers are prompted to 
select a mailbox?

If you create a multiple mailbox profile, you can 
use a mailbox menu—a message that prompts 
callers to select a mailbox. Mailbox menus are 
played between the main greeting and a 
mailbox greeting. You can use either the 
TalkWorks mailbox menu, or record your own.
The TalkWorks mailbox menu prompts callers 
to enter the mailbox number (they must know it 



ahead of time). If you record a custom mailbox 
menu, consider providing the mailbox names 
and numbers for callers (for example, “Press 
one for Sales. Press 2 for Service.”).

Mailbox names and 
mailbox numbers

What mailbox names and 
numbers do you want to 
use?

Assign a mailbox name and a mailbox number 
to each mailbox in your system. Remember that
longer numbers are harder for callers to 
remember and enter correctly. If you need a 
general mailbox, consider setting up a mailbox 
with the mailbox number “0”. By default, 
TalkWorks assigns “0” to the Receive Log, but 
you can change this at any time.

Mailbox greetings

What kind of greeting do 
you want callers to hear 
when they select a 
mailbox?

Single mailbox profiles – If you create only 
one mailbox, TalkWorks plays only a mailbox 
greeting; it does not allow you to use a 
separate main greeting. When planning the 
main greeting for a single mailbox profile, keep 
in mind that callers will hear only one greeting, 
and that greeting should give them the 
information they need to use your system.

Multiple mailbox profiles – Typically, each 
mailbox in a multiple mailbox profile has a 
greeting (except for Data Only mailboxes, 
which do not play a greeting); however, you 
may decide that some mailboxes do not need a
greeting. If you do not select a greeting, 
consider the impact this has on your main 
greeting or mailbox menu. For example, you 
might want to record a mailbox menu and 
explain to callers that they can leave a 
message immediately after selecting a mailbox.
Voice Message mailbox greetings typically state
your name and invite callers to leave a 
message. Announcement Only mailbox 
greetings provide callers with information. Fax 
On Demand mailbox greetings might describe 
the documents available. Fax Only mailbox 
greetings might tell callers how to send a fax to 
the mailbox. Data Only mailboxes cannot have 
a greeting.

Dual line support

Do you want to use two 
phone lines? If so, what is 
each line used for?

Using WinFax and TalkWorks, you can set up 
your system to use two phone lines and two 
modems. For example, you could reserve one 
line for incoming fax and voice calls, and one 
for outgoing faxes and voice calls. Or, you 
could use one line for fax calls, and the other 
for voice calls. 

 Distinctive ring 

Do you subscribe to this 
service?

If you are using Unimodem V under Windows 
95 or Windows NT 4.0, TalkWorks supports 
distinctive ring. This feature is set up in 
Windows (see your Windows documentation). 

 Related Topics



More information needed ...
What type of mailbox do you want to create?

               Voice Message mailbox  
               Announcement Only mailbox  
               Fax On Demand mailbox  
               Fax Only mailbox  
               Data Only mailbox  



Setting up the Answering Machine

During installation, TalkWorks creates a default TalkWorks profile named “My Sample Single Mailbox Profile”. This
single mailbox profile is set up to play the default TalkWorks greeting (“This call is being answered by TalkWorks”)
and store incoming voice messages and faxes in the Receive Log folder. The default profile is ready to use—all 
you need to do is turn it on.

To turn on automatic reception, enable Automatic Receive on the Receive menu in WinFax. When TalkWorks 
detects an incoming call, it will answer the call after two rings (unless you change this setting). You can disable 
automatic reception for both voice and fax at any time. Or, you can disable automatic reception for voice if you 
want to receive faxes only.

Before you use the default profile, you may wish to customize it to meet your call answering requirements. 
Typically, you might want to change the mailbox greeting or enable remote access so you can retrieve messages 
from any touch tone phone.

If you want to create a new profile or modify the default profile, you can do so at any time.

Note to upgraders

If you are upgrading from a previous version of TalkWorks, the Setup program saves your pre-existing call 
answering system as the default profile. This profile is named “My TalkWorks Profile”.



Sample profile

The script below represents a sample TalkWorks profile. Your call answering system may contain some or all of 
these types of mailboxes. 

(Main greeting)
Welcome to Weldon & Garcia Associates

(Mailbox menu)
Please enter the mailbox number ...

               0   (Voice Message)  
               1   (Voice Message)  
               2   (Announcement Only)  
               3   (Fax On Demand)  
               4   (Fax Only)  
               5   (Data Only)  

The scenarios below represent what happens when you select each of the mailboxes. The greetings used below 
are custom greetings.

If the caller presses press “0” ...

Thank you for calling Weldon & Garcia. No one is available to take your 
call. Please leave your name, phone number and message and we will 
return your call. (mailbox greeting)

<beep> ... and then the caller leaves a message
This is Natasha Irvine calling for Gregory Rankin. I’m calling to discuss the
agenda for the meeting tomorrow. Please call me at 555-1287 as soon as 
possible.

If the caller presses “1” ...

Hi, this is Hilary Kellough at Weldon & Garcia Associates on Wednesday, 
November 1st. I can’t take your call right now. Please leave your name, 
number and message after the beep. (mailbox greeting)

<beep> ... and then the caller leaves a message
Sharon, this is Tyrone Stewart at MacDonald Motors. Your car is ready for 
pickup. If you need someone to pick you up, please call me at 555-8721 
before 4:00 p.m. today.



If the caller presses “2” ...

Weldon & Garcia Associates is located at 274 Main Street, Boston, 
Massachusetts. The zip code is 26381 You may fax us at (617) 555-1274 
(announcement greeting)

<pause> ... and then TalkWorks plays the announcement again
Weldon & Garcia Associates is located at 274 Main Street, Boston, 
Massachusetts. The zip code is 26381 You may fax us at (617) 555-1274

If the caller presses “3” ...

Thank you for calling our fax info line.
For our catalog, press 1
For our price list, press 2
For a list of stores that carry our product line, press 3 (document menu)

... the caller presses the appropriate number and TalkWorks prepares to send the 
fax



Caller presses “0” ...

Thank you for calling Weldon & Garcia. No one is available to take your call. Please leave your name, phone 
number and message and we will return your call. (mailbox greeting)

<beep> ... caller leaves a message

This is Natasha Irvine calling for Gregory Rankin. I’m calling to discuss the agenda for the meeting tomorrow. 
Please call me at 555-1287 as soon as possible.



Caller presses “1” ...

Hi, this is Hilary Kellough at Weldon & Garcia Associates on Wednesday, November 1st. I can’t take your call right
now. Please leave your name, number and message after the beep. (mailbox greeting)

<beep> ... and then the caller leaves a message

Sharon, this is Tyrone Stewart at MacDonald Motors. Your car is ready for pickup. If you need someone to pick 
you up, please call me at 555-8721 before 4:00 p.m. today.



Caller presses “2” ...

Weldon & Garcia Associates is located at 274 Main Street, Boston, Massachusetts. The zip code is 26381 You 
may fax us at (617) 555-1274 (announcement greeting)

<pause> ... and then TalkWorks repeats the announcement

Weldon & Garcia Associates is located at 274 Main Street, Boston, Massachusetts. The zip code is 26381 You 
may fax us at (617) 555-1274



Caller presses “3” ...

Thank you for calling our fax info line.
For our catalog, press 1
For our price list, press 2
For a list of stores that carry our product line, press 3 (document menu)

The caller presses the appropriate number and TalkWorks prepares to send the fax.



Caller presses “4” ...

Start sending your fax at any time. When you are finished sending your fax, hang up. (mailbox greeting)

TalkWorks prepares to receive the fax.



Caller presses “5” ...

TalkWorks goes into data mode and prepares for the data connection. 



Planning Voice Message mailboxes 

Voice Message mailboxes record voice messages and receive faxes. When a caller selects this type of mailbox, 
TalkWorks plays the mailbox greeting, then records any message the caller leaves. You can use Voice Message 
mailboxes in a wide variety of ways. For example, you might want to create mailboxes for each member in your 
group, or you might want to create separate mailboxes for different types of inquiries and messages.

When you plan a Voice Message mailbox, consider the issues described in the table below. Click here  for 
instructions on how to create a Voice Message mailbox.

Mailbox feature Design considerations

Mailbox name
(required)

What mailbox name do you want to use? This 
is the name of the mailbox folder in the Logs 
window and the name that appears in the list of 
available mailboxes. 

      Mailbox number
(required)

Multiple mailbox profiles only – What mailbox
number do you want to use? This is the number
that callers will use to access the mailbox.

Mailbox greeting
(optional)

What greeting do you want callers to hear when
they access the mailbox? You can record a 
greeting, select one of the prerecorded 
greetings included with TalkWorks, or import an
audio file stored on your computer.

Schedule greeting
(optional)

Do you want to use two different mailbox 
greetings, depending on the time of day or 
week? If yes, what greeting do you want callers
to hear? What should the schedule be?

Remote access
(optional)

Do you want to be able to pick up messages 
from a remote phone? If yes, what password do
you want to use for this mailbox (must be 2 to 8
digits long)?

Traffic logging
(optional)

Do you want to enable traffic logging so that all 
incoming calls are logged, even when callers 
do not leave messages?

 Related Topics



Planning Announcement Only mailboxes

When a caller selects an Announcement Only mailbox, TalkWorks plays the mailbox greeting or “announcement”, 
then hangs up. Callers cannot leave messages. Announcement mailboxes are useful, for example, when you want
to provide information to callers, such as your business location or hours. By confining that information to an 
Announcement Only mailbox, only those callers who select that mailbox will listen to that information.

When you plan an Announcement Only mailbox, consider the issues described in the table below. Click here  for 
instructions on how to create an Announcement Only mailbox.

Mailbox feature Design considerations

Mailbox name
(required)

What mailbox name do you want to use? This 
is the name of the mailbox folder in the Logs 
window. Typically, you might select a name 
corresponding to the announcement message 
(for example, “Hours” or “Location”). 

Mailbox number
(required)

Multiple mailbox profiles only - What mailbox
number do you want to use? This is the number
that callers will use to access the mailbox.

Announcement greeting
(required)

What information do you want to provide to 
callers listening to this message? You can 
record an announcement or import an audio file
stored on your computer.
After listening to the announcement, callers can
press the star (*) key to return to the main 
menu. If you want users to know about this, 
mention this information in your announcement 
or main greeting. 

Schedule announcement
(optional)

Do you want to use two different mailbox 
announcements, depending on the time of day 
or week? If yes, what announcements do you 
want callers to hear? What should the schedule
be?

Remote access
(optional)

Do you want to be able to change your 
announcement from a remote phone? If yes, 
what password do you want to use for this 
mailbox (must be 2 to 8 digits long)?

Traffic logging
(optional)

Do you want to enable traffic logging so that all 
incoming calls are logged? This feature is 
useful, for example, if you want to track the 
number of callers that listen to your 
announcement message.

 Related Topics



Planning Fax On Demand mailboxes

When a caller selects a Fax On Demand mailbox, TalkWorks plays the mailbox greeting, then prompts callers to 
select documents to be faxed back to them. After the caller selects the documents they want, TalkWorks prompts 
them to specify their fax number (area code + local number + the # key to complete their request). TalkWorks is 
then ready to fax the selected documents. 

Fax On Demand mailboxes cannot fax to overseas fax numbers (for example, from North America to overseas 
countries).

When you plan a Fax On Demand mailbox, consider the issues described in the table below. Click here  for 
instructions on how to create a Fax On Demand mailbox.

Mailbox feature Design considerations

Mailbox name
(required)

What mailbox name do you want to use? 
Typically, you might select a name that 
corresponds to the documents in the mailbox. 

Mailbox number
(required)

Multiple mailbox profiles only – What mailbox
number do you want to use? This is the number
that callers will press to access the mailbox.

Documents
(required)

Which documents do you want to provide as 
faxes? Before you can assign documents to the
mailbox, each must be converted into an 
attachment. Assign names and numbers to your
documents and consider the appropriate order. 
For example, do you want to provide the most 
frequently requested documents earlier in the 
menu? 

Document menu
(required)

TalkWorks plays a document menu that 
prompts callers to select documents. You can 
use the TalkWorks document menu, or you can 
record a custom document menu. For example,
“Press 1 to select a fax about product A, press 
2 for a fax about product B”.

Fax back options
(required)

You can set up this type of mailbox so that 
callers have one or both of the following fax 
back options:

Send faxes to the caller during the 
same call – Callers must be calling from a fax 
machine or from a fax/telephony program like 
WinFax. (Caller pays long distance charges.)

Send faxes to the number callers 
specify – TalkWorks prompts the caller to enter
a fax number. When the caller hangs up, 
WinFax sends the fax. Because users can 
specify only ten digits for their fax number (area
code and local number), this option is not 
available for overseas calls. (You pay long 
distance charges.)

Cover page
(optional)

You can send a cover page with each set of 
faxes. If you wish, you can customize the cover 
page to include a subject line, a text message 
and a logo or graphic.

Traffic logging
(optional)

Do you want to enable traffic logging so that all 
incoming calls are logged?

 Related Topics



Planning Fax Only mailboxes

Fax Only mailboxes automatically switch to fax-reception mode when callers access them. This type of mailbox is 
useful for callers who send faxes using older fax machines that do not produce standard fax tones.

When a caller selects this type of mailbox, TalkWorks plays the mailbox greeting, then prepares to receive a fax. 
At that point, the mailbox is ready to begin communicating with the modem on the other end of the line. Typically, 
users would be calling from a fax machine and would press the Send button when they are ready to send the fax.

When you plan a Fax Only mailbox, consider the issues described in the table below. Click here  for instructions 
on how to create a Fax Only mailbox.

Mailbox feature Design considerations

Mailbox name
(required)

What mailbox name do you want to use? This 
is the name of the mailbox folder in the Logs 
window and in the list of available mailboxes. 

Mailbox number
(required)

Multiple mailbox profiles only – What mailbox
number do you want to use? This is the number
that callers will use to access the mailbox.

Mailbox greeting
(optional)

What greeting do you want callers to hear when
they access the mailbox and before they send a
fax? Although you could use a prerecorded 
TalkWorks greeting, it probably does not 
provide you with what you need. Typically, you 
would record a greeting that instructs callers 
how to send a fax to the mailbox (for example, 
“Start sending your fax at any time. When you 
are finished sending your fax, hang up.”). 

Schedule greeting
(optional)

Typically you would not schedule your greetings
for a Fax Only mailbox because callers can call 
your system and send faxes at any time. 

Remote access
(optional)

Do you want to be able to pick up faxes from a 
remote phone? If yes, what password do you 
want to use for this mailbox (must be 2 to 8 
digits long)?

Traffic logging
(optional)

Do you want to track the calls coming into this 
mailbox?

 Related Topics



Planning Data Only mailboxes

When a caller accesses a Data Only mailbox, TalkWorks hands the call over to a data communications program 
(such as pcANYWHERE or Microsoft RAS). This feature provides remote access to your computer without having 
to set up a dedicated phone line. By adding a Data Only mailbox to your call answering system, your computer 
can answer all types of calls—fax, voice, and data—using only one phone line.

For callers to use your Data Only mailbox, you must first instruct them to add the appropriate information to their 
dial sequence so they can navigate your call answering system and access the mailbox. For example, callers may
need to add several commas for pausing (giving TalkWorks time to answer), the mailbox number, followed by 
another comma. You can either instruct callers ahead of time or provide them with some basic information in the 
script of your mailbox menu. For example, their dial sequence might look like the following ...

555-1212,,,3,

... where the three commas give TalkWorks time to answer the phone, the number “3” is the Data Only mailbox 
number and the final comma gives TalkWorks time to access the selected mailbox. 

Depending on your security requirements, you may also want to “hide” this mailbox from callers by excluding it 
from your recorded mailbox menu. That way, only people you notify personally will know about your Data Only 
mailbox.

When you plan a Data Only mailbox, consider the issues described in the table below. Click here  for instructions 
on how to create a Data Only mailbox.

Mailbox feature Design considerations

Mailbox name
(required)

What mailbox name do you want to use? This 
is the name that appears in the list of available 
mailboxes.

Mailbox number
(required)

What mailbox number do you want to use? This
is the number that callers will use to access the 
mailbox.

Traffic logging
(optional)

Do you want to enable traffic logging? This 
feature is useful, for example, if you want to 
track how many callers access this mailbox. 

 Related Topics



Planning greetings and menus

Depending on how your TalkWorks profile is set up, callers may listen to one or more greetings and menus that 
guide them through your call answering system. Using greetings and menus, you can control what callers hear.

There are five types of greetings:

Main greeting – The first greeting played when TalkWorks answers the call.
Mailbox menu – The message TalkWorks uses to ask the caller to enter the mailbox number in a multiple 

mailbox system.
Mailbox greeting – The greeting callers hear when they access a mailbox in a multiple mailbox system.
Announcement – The message callers hear when they access an Announcement Only mailbox.
Document menu – The message TalkWorks uses to ask callers which document they want faxed to them in

a Fax On Demand mailbox.
When you choose a greeting, you can either select one of the prerecorded greetings in the Cover Your Voice 
collection (included with TalkWorks), record your own customized greeting, or import an audio file. Similarly, when 
you select a menu, you can either use a menu provided by TalkWorks, or you can record your own.

Using TalkWorks Prerecorded Greetings

The Cover Your Voice collection of prerecorded greetings includes professionally recorded business and 
humorous greetings. If you are concerned about disk space, you can delete those greetings you are least likely to 
use. If you have deleted this collection, you can run the WinFax Setup program at any time to reinstall it. 
Additional greetings can be downloaded from the Symantec Web site. 

Recording Greetings

You can record greetings when you create a profile using the TalkWorks wizard, you can record ahead of time 
using the TalkWorks AudioEditor. Because the tone and quality of the prompts affect the caller’s impression, it is 
important to make your recorded messages appear as clear and brief as possible.

When you record greetings, you can add them to the list of prerecorded greetings. This allows you to save 
greetings you want to use regularly.

Consider the following issues when you plan your greetings:

Listen to the TalkWorks prerecorded greetings – The TalkWorks greetings may give you ideas for 
recording your own.

Plan your greetings – Write down the text for each greeting. Keep your messages as brief as possible. 
Provide helpful hints to callers. For example, you might tell them that, after they finish recording their message, they 
can press the number key (#) to terminate a call, or the star key (*) to return to the main menu. This may be useful if 
you anticipate callers might want to access more than one mailbox during a single call (as might be the case with a 
fax back system). Practise recording your greetings before you start recording.

Choose a voice – Greetings sound better if they are made by someone with clear pronunciation and a 
pleasant voice.

Select your hardware and recording levels – If your computer includes a microphone and sound card, as 
well as a phone connected to your modem, you can record greetings using either the phone handset or the 
microphone. 

When you select a recording device, your choices will depend on your system setup. Recording quality may 
vary with each device. However, if you have a computer sound card, this device will typically produce the best results.

Prepare a test message and record it using each device on your computer. Listen to each message to 
determine which device produces the best quality recording. Adjust the device settings and repeat the test until
you determine the optimal settings for your computer.

When recording, use the highest recording level that does not cause distortion. Play back your recorded 
greeting and listen for clipping.

Avoid background noise – Eliminate sources of background noise, or move as far away from them as 
possible.

Position your microphone or handset properly – Hold the handset about one inch away from your mouth 
and a little to one side. Experiment to obtain the best possible results. For more information, see the documentation 
for your sound card.

Importing Greetings

If you are using TalkWorks in an environment where recording quality is important, you can professionally record 



material and import each audio file (.WAV format) as a TalkWorks greeting. These files will be automatically 
converted to the format required by your modem as they are imported.

 Related Topics



Planning forms

After you have reviewed all the planning information, we recommend that you fill in the planning forms in your 
User’s Guide and refer to them while you use the TalkWorks wizard to create your profile. 



Setting Up Call Answering



WinFax main window
Creating a profile

1 Plan your TalkWorks profile. For more information, click here .

2 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

3 Click the Profiles tab.

4 Click Add. The TalkWorks wizard starts.

5 In the Profile Name field, type the name you want to use for your TalkWorks profile and then click Next.

6 Do one of the following:

Create a single mailbox profile – Click Direct All Calls To A Single Mailbox and click Next.
Create a multiple mailbox profile – Click Have The Caller Select One Of The Multiple Mailboxes I Create 

and click Next.
7 Follow the instructions on the screen to configure the profile. Click Next to proceed.

8 On the Available Mailboxes panel, do one of the following:

Mailboxes have not been created – Click Add and create the appropriate mailboxes. For more information,
click here 
.

Mailboxes have already been created – Assign a mailbox number to each mailbox you want to include in 
this profile. In the Available Mailboxes list, click the mailbox and then click the appropriate mailbox number in the 
Selected Mailbox Number drop-down list.

9 Click Next to proceed.

10 On the Profile Summary panel, click Finish.

 Related Topics



More information needed ...
What type of mailbox do you want to create?

               Voice Message mailbox  
               Announcement mailbox  
               Fax On Demand mailbox  
               Fax Only mailbox  
               Data Only mailbox  



WinFax main window
Creating a Voice Message mailbox

1 Plan your Voice Message mailbox. For more information, click here .

2 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

3 Click the Mailboxes tab.

4 Click Add. The TalkWorks wizard starts.

5 In the Mailbox Name field, type the name for the mailbox.

6 In the Mailbox Type drop-down list, click Voice Message and then click Next.

7 Follow the instructions on the screen. Click Next to proceed.

8 On the Mailbox Summary panel, click Create to create the mailbox.

9 Add your mailbox to a profile. For more information, click here .



WinFax main window
Creating an Announcement Only mailbox

1 Plan your Announcement Only mailbox. For more information, click here .

2 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

3 Click the Mailboxes tab.

4 Click Add. The TalkWorks wizard starts.

5 In the Mailbox Name field, type the name for the mailbox.

6 In the Mailbox Type drop-down list, click Announcement Only, and then click Next.

7 Follow the instructions on the screen. Click Next to proceed.

8 On the Mailbox Summary panel, click Create to create the mailbox.

9 Add your mailbox to a profile. For more information, click here .



WinFax main window
Creating a Fax Only mailbox

1 Plan your Fax Only mailbox. For more information, click here .

2 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

3 Click the Mailboxes tab.

4 Click Add. The TalkWorks wizard starts.

5 In the Mailbox Name field, type the name for the mailbox.

6 In the Mailbox Type drop-down list, click Fax Only, and then click Next.

7 Follow the instructions on the screen. Click Next to proceed.

8 On the Mailbox Summary panel, click Create to create the mailbox.

9 Add your mailbox to a profile. For more information, click here .



WinFax main window
Creating a Data Only mailbox

1 Plan your Data Only mailbox. For more information, click here .

2 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

3 Click the Mailboxes tab.

4 Click Add. The TalkWorks wizard starts.

5 In the Mailbox Name field, type the name for the mailbox.

6 In the Mailbox Type drop-down list, click Data Only, and then click Next.

7 Follow the instructions on the screen. Click Next to proceed.

8 On the Mailbox Summary panel, click Create to create the mailbox.

9 Add your mailbox to a profile. For more information, click here .



WinFax main window
Preparing Fax On Demand documents

1 Plan your Fax On Demand mailbox. For more information, click here .

2 Create a list of documents you want to add to your Fax On Demand mailbox. Assign a document name and 
document number to each one.

3 Open the first document in the Windows program you used to create it. Proofread it carefully.

4 On the program’s File menu, click Print (or the equivalent command). A print dialog appears.

5 Select the WinFax printer and print the document. The WinFax PRO Send dialog appears and displays the 
following message in the Attachments section ...

“Item to print + 0 attachments selected”

... where “Item to print” indicates that the document you printed is ready for faxing.

6 Click Make Attachment. The Create Attachment dialog appears.

7 Click Save In Directory Only.

8 In the File Prefix field, type the document name and click OK. WinFax converts your document into a WinFax 
attachment. 

9 Repeat steps 3 through 8 for each document you want to add to your Fax On Demand mailbox.

10 Create the Fax On Demand mailbox. For more information, click here .

Note

WinFax creates a separate fax image file for each page of your document, incrementally adding page 
numbers to the file name. For example, WinFax converts your 10-page report into 10 .FXS files using the prefix you 
specified plus a page number (for example, REPORT001.FXS, REPORT002.FXS, REPORT003.FXS, and so on).



WinFax main window
Creating a Fax On Demand mailbox

1 Plan your Fax On Demand mailbox. For more information, click here .

2 Prepare your Fax On Demand documents. For more information, click here .

3 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.
4 Click the Mailboxes tab.
5 Click Add. The TalkWorks wizard starts and the General panel appears.
6 In the Mailbox Name field, type the name for the mailbox.
7 In the Mailbox Type drop-down list, click Fax On Demand.
8 In the Fax Back Options section, click the appropriate option.

9 Click Next. The Cover Page panel appears.

10 Select a cover page (optional). Do the following:

a Enable Send A Cover Page When Faxing.
b Select the appropriate cover page options.

11 Click Next. The Documents panel appears.

12 Click Add to add documents to your mailbox. The Add Document To Mailbox panel appears.

13 In the Document Name field, type a descriptive name for the document.

14 Click Add, select the files that comprise your document (one .FXS file for each page of the document), and 
then click Open.

15 Use the Up and Down arrow buttons to ensure the pages in the document are in the correct order, then click 
OK. The Document panel reappears and displays the document in the list.

16 Click the document.

17 In the Document Number drop-down list, click a document number.

18 Repeat steps 12 through 17 until all documents are added to the mailbox.

19 Click Next. The Menu panel appears.

20 Click one of the following options:

Play Only The TalkWorks Document Prompt – Click this option if you think callers already know the 
document numbers.

Play A Custom Document Menu That I Record – Click this option if callers do not know the document 
numbers. Click the Record button and record your document menu, using the text provided as a guide.

21 Continue clicking Next and selecting the appropriate options until you reach the last panel of the wizard, which
lists a summary of all the options you selected for this mailbox. Click Create to create the mailbox.

22 Add your mailbox to a profile. For more information, click here .



WinFax main window
Adding a mailbox to a profile

1 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

2 Click the Profiles tab.

3 In the Profiles Currently Set Up list, click the profile to which you want to add a mailbox.

4 Click Properties. The TalkWorks wizard starts and the Call Management panel appears.

5 Click Have The Caller Select One Of The Multiple Mailboxes I Create and click Next.

6 Click Next until the Available Mailboxes panel appears.

7 In the mailbox list, click the mailbox you want to add to the profile.

8 In the Selected Mailbox Number drop-down list, click the appropriate mailbox number and click Next.

9 Click Next until the Profile Summary panel appears.

10 Click Finish.

Notes

You may need to modify the mailbox numbers for the other mailboxes in the profile to coordinate all the 
numbers in your call answering system.

“Disabled” indicates that the mailbox is not used by this profile. 



WinFax main window
Modifying a profile

1 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

2 Click the Profiles tab.

3 In the Profiles Currently Set Up list, click the profile you want to modify.

4 Click Properties. The TalkWorks wizard starts.

5 Follow the instructions on the screen to make the appropriate changes.

6 On the Profile Summary panel, click Finish to save your changes.



WinFax main window
Modifying a mailbox

1 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

2 Click the Mailboxes tab.

3 In the Mailboxes Currently Setup list, click the mailbox you want to modify.

4 Click Properties. The Mailbox Properties dialog appears.

5 Make the appropriate changes.



WinFax main window
Deleting a profile

1 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

2 Click the Profiles tab.

3 In the Profiles Currently Set Up list, click the profile you want to delete.

4 Click Remove. 



WinFax main window
Deleting a mailbox

1 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

2 Click the Mailboxes tab.

3 In the Mailboxes Currently Setup list, click the mailbox you want to delete.

4 Click Remove.

Notes

You cannot delete the Receive Log.
To remove a mailbox from a profile, run the TalkWorks wizard and assign the mailbox you want to disable 

the “Disabled” mailbox number.



WinFax main window
Testing a profile

1 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

2 Click the Profiles tab.

3 In the Profiles Currently Set Up list, click the profile you want to test.

4 Click Test. The TalkWorks Simulator appears.

5 Follow the prompts.

6 Click Close to exit.



WinFax main window
Enabling a profile

1 Enable automatic reception for voice and fax. For more information, click here .

2 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

3 Click the Profiles tab.

4 In the Active Profile section, click the profile you want to use in the appropriate drop-down list.

Note

If you have two phone lines and two voice modems connected to your computer, the Active Profile section 
contains two drop-down lists, one for Line 1 and one for Line 2. You can activate a different profile on each line or you
can activate the same profile on both lines.



WinFax main window 
Enabling automatic receive for both voice and fax

1 On the Setup menu in WinFax, click Receive. The Receive Properties dialog. 

2 Click the General tab.

3 In the When A Call Comes In On drop-down list, click the line for which you want to specify automatic 
reception options. (This drop-down list appears only if you have two phone lines and two modems connected 
to your computer.)

4 Enable Automatically Answer Incoming Calls.

5 In the Answer After ... Ring(s) field, type the number of times you want WinFax to let the phone/modem ring 
before answering.

6 Click Schedule. The Schedule Automatic Receive dialog appears.

7 Do one of the following:

If you want to enable automatic receive at all times, click Always On.
If you want to schedule automatic receive, click Scheduled, select the appropriate times and days and click 

OK. The Receive Properties dialog reappears.
8 If you subscribe to a call waiting service, enable This Line Has Call Waiting to disable call waiting when 

receiving faxes.

Notes

You can also enable and disable automatic reception using the Automatic Receive command on the Receive
menu in WinFax or from the Controller menu.

You can also open the Receive Properties dialog from the Answering Machine (click the Menu button and 
then click Receive Setup).



WinFax main window 
Switching to fax-only reception

1 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears. 

2 Click the Profiles tab.

3 In the Active Profile section, click the Fax Only profile in the appropriate drop-down list.

Note

You can also open the TalkWorks Properties dialog from the Answering Machine (click the Menu button and 
then click TalkWorks Setup).



Options (Shared with WinFax)



WinFax main window, Telephone
Setting modem options

The Setup program automatically sets up your modem. WinFax and TalkWorks share common settings for 
modems. You can add additional modems at any time or modify your modem settings in the Modem Properties 
dialog. You can open the Modem Properties dialog from WinFax (on the Setup menu, click Modem) or from either 
the Telephone or the Answering Machine (click the Menu button and then click the modem setup command).

The following topics provide instructions on how to change your modem setup from the Modem Properties dialog. 
Click the appropriate topic.

               Setting up a modem  
               Activating a modem  
               Changing modem settings  
               Testing your computer for attached modems  



WinFax main window, Telephone
Specifying dialing instructions

WinFax and TalkWorks share many common settings for dialing, including your location settings. 

You can customize these common settings at any time in the Dialing Properties dialog. You can open the Dialing 
Properties dialog from WinFax (on the Setup menu, click Dialing) or from the Telephone (click the Menu button 
and then click Setup Dialing).

The following topics provide instructions for changing your dialing setup from the Dialing Properties dialog. Click 
the appropriate topic below.

               Setting up a new location  
               Modifying an existing location  
               Removing a location  

If you are using the TalkWorks Telephone to place voice calls, you can also adjust a variety of dialing-related 
settings. Click the appropriate topic below.

               Handling dial tones and busy signals  
               Setting automatic redial options  



WinFax main window, Telephone
Specifying credit card options

WinFax and TalkWorks share common credit card settings. You can customize these settings at any time in the 
Dialing Properties dialog. You can open the Dialing Properties dialog from WinFax (on the Setup menu, click 
Dialing) or from the Telephone (click the Menu button and then click Setup Dialing).

The following topics provide instructions on how to change your dialing setup from the Dialing Properties dialog. 
Click the appropriate topic below.

               Setting up a new credit card  
               Setting up credit card dial sequences  
               Modifying credit card information  
               Removing a credit card  
               Renaming a credit card  
               Charging a call to a credit card or calling card  



Options (Voice/Voice Answer - TAM)



WinFax main window
Setting message length options

1 On the Setup menu in WinFax, click Receive. The Receive Properties dialog appears.

2 Click the Voice Answer tab.

3 In the Do Not Accept Messages Shorter Than field, type the minimum message length, in seconds. The 
default setting is two seconds.

4 In the Stop Recording Messages After field, type the maximum message length, in seconds. (The default 
setting is 180 seconds.)

Note

Specify a minimum message length to prevent TalkWorks from recording messages when the caller has 
hung up without saying anything.



WinFax main window
Compressing voice messages

1 Select the compression method you want to use for voice messages. Do the following:

a On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.
b Click the Devices tab.
c Click Advanced. The Tune Performance dialog appears.
d Select the appropriate options in the Recording and Playback sections and click OK. Use the table below 

to select the appropriate settings for your computer.

Computer Settings

486 or Pentium processor – 
Compress messages during playback
and recording 

Faster Computer 
Faster Computer

486 or Pentium processor with a 
fast disk – Compress messages 
while playing, and in a buffer during 
recording

Fast Computer, Fast Disk
Faster Computer

386 processor – Compress voice 
messages after playback and 
recording

Slower Computer
Slower Computer 

e Click OK. 

2 Select the compression level you want to use. Do the following:

a On the Setup menu in WinFax, click Receive. The Receive Properties dialog appears.
b Click the Voice Answer tab.
c In the Compression drop-down list, click the appropriate compression level. If you want high quality 

messages, regardless of the amount of disk space they use, click Best Quality. If you want to minimize the 
disk space used by voice messages, click Best Compression.

Notes

The speed of your computer determines whether TalkWorks compresses voice wave files during or after 
recording and playback. TalkWorks detects your processor speed during installation, and sets wave compression 
accordingly.

You can only specify the compression method if you are using one of the (Wave) playback or recording 
devices.



WinFax main window
Using the 24-hour clock to announce the message time

1 On the Setup menu in WinFax, click Receive. The Receive Properties dialog appears.

2 Click the Voice Answer tab.

3 In the Options section, enable Announce Message Time Using 24-Hour Clock.

Notes

If you disable this option, TalkWorks announces the time messages were left using the 12-hour clock with 
the appropriate a.m. or p.m. label.

TalkWorks plays the message time when you retrieve your messages remotely. In the Receive Log, check 
the message time in the Time column. In the Answering Machine, the message time appears in the call display 
screen during playback.



WinFax main window
Setting playback device options

1 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

2 Click the Devices tab.

3 In the Select A Device To Be For Playing Back Messages And Greetings drop-down list, click the hardware 
device you want to use (some options are hardware dependent). 

Windows Sound System – TalkWorks plays back your voice messages through the microphone attached to
your computer’s sound card.

Speaker – TalkWorks plays back your voice messages through speakers plugged into your system.
Telephone Set – TalkWorks prompts you to pick up your handset to hear voice messages played back to 

you.
Dial Phone Number – TalkWorks calls a specified phone number to play back your voice messages.

4 If you selected the Dial Phone Number option, type the appropriate phone number in the Phone Number field.

5 Drag the Playback Volume slide control to the appropriate level.

Note

The contents of the playback drop-down vary, depending on your hardware. If you have a sound card, the 
default is Windows Sound System (Recommended). If not, the default is Telephone Set.



WinFax main window
Setting recording device options

1 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

2 Click the Devices tab.

3 In the Select A Device For Recording Memos And Greetings, click the hardware device you want to use (some
options are hardware dependent):

Windows Sound System – Record your voice messages through the microphone attached to your 
computer’s sound card.

Microphone – Record your messages through your system’s microphone, if available.
Telephone Set – TalkWorks prompts you to pick up your handset to record your voice messages.
Dial Phone Number – TalkWorks calls a specified phone number to record your voice messages.

Note

The contents of the recording drop-down list vary, depending on your hardware. If you have a sound card, 
the default is Windows Sound System (Recommended). If not, the default is Telephone Set.



WinFax main window
Using the toll saver feature

1 On the Setup menu in WinFax, click Receive. The Receive Properties dialog appears.

2 Click the Voice tab.

3 In the Toll Saver section, enable Extend The Number Of Rings By Two When There Are No New Messages In 
Any Of The Mailboxes Used By The Active Profile.

Note

Use this option to identify if you have new messages when you call in from an outside line. If there are no 
new messages, your phone will ring two more times than it normally would if TalkWorks were answering the call, 
giving you time to hang up.



WinFax main window
Screening voice calls

1 On the Setup menu in WinFax, click Receive. The Receive Properties dialog appears.

2 Click the Voice tab.

3 In the Call Screening section, enable Listen To Callers As They Leave Messages.

4 Drag the Volume slide control to the appropriate level.

Notes

Use this option to hear callers through your speaker as they leave voice messages. You can then decide 
whether to pick up each call or let TalkWorks continue to record the message.

You can only screen your calls if your hardware supports call screening.



WinFax main window
Handling fax calls

1 On the Setup menu in WinFax, click Receive. The Receive Properties dialog appears.

2 Click the Voice tab.

3 In the Eavesdropping section, enable Have The Modem Listen For Fax Tones On All Incoming Calls.

Note

When this option is enabled, WinFax detects and takes over an incoming fax call, even if you pick up the 
handset first. To manually switch to fax mode at any time before or after you pick up the phone, click the Fax button 
on the Telephone.



Telephone
Putting a call on hold

1 Start the Telephone.

2 During the call, click Hold. TalkWorks puts the current line on hold.



WinFax main window
Forwarding voice messages

1 On the Window menu, click Receive Log. The Logs window opens to display the Receive Log folder.

2 If you set up multiple mailboxes, click the mailbox containing the message you want to forward.

3 On the Send menu, click Forward. 

4 Address the fax.

5 In the text area, type a message.

6 Click Send.



WinFax main window
Using the scroll lock light to signal new messages

1 On the Setup menu in WinFax, click Receive. The Receive Properties dialog appears.

2 Click the After Receive tab.

3 Enable Notify.

4 Enable Flash Scroll Lock.



WinFax main window
Setting sensitivity to sound

1 On the Setup menu in WinFax, click Receive. The Receive Properties dialog appears.

2 Click the Voice tab.

3 Drag the Sensitivity slide control to the appropriate sensitivity level.



WinFax main window
Viewing the tracking log for a mailbox

1 On the TalkWorks menu in WinFax, click Setup. The TalkWorks Properties dialog appears.

2 Click the Mailboxes tab.

3 In the Mailboxes Currently Setup list, click the appropriate mailbox.

4 Click View Log. TalkWorks opens the log file for the selected mailbox in Notepad.



Options (Telephone)



Telephone
Specifying the modem you want to use

1 Start the Telephone.

2 Click the Menu button and then Setup Telephone. The Telephone Properties dialog appears.

3 Click the General tab.

4 In the Connect Using drop-down list, click the modem you want to use.



Telephone
Handling dial tones and busy signals

1 Start the Telephone.

2 Click the Menu button and then click Setup Telephone. The Telephone Properties dialog appears.

3 Click the General tab.

4 If you want to start dialing numbers only after a dial tone is detected, enable Wait For Dial Tone Before Dialing.
Otherwise, dialing may start before you actually connect to an outside line.

5 If you want to recognize busy tones, enable Detect Busy Signal (Required For Redial). If this option is enabled
and a call fails because the receiving line is busy, this information appears in the message’s transmission 
details in the Outbox. Otherwise, the reason the call failed is not reported.



Telephone
Setting automatic redial options

1 Start the Telephone.

2 Click the Menu button and then click Setup Telephone. The Telephone Properties dialog appears.

3 Click the General tab.

4 In the Options section, enable Detect Busy Signal (Required For Redial).

5 In the Redial section, do one of the following:

If you want to attempt to redial a busy number for a specific period of time, click Redial For and type the 
appropriate times in the Minutes and Seconds fields.

If you want to attempt to redial a busy number for a set number of times, click Redial and type the number of
times in the field.

6 In the Pause For field, type the number of seconds you want to wait between attempted redials.



Telephone
Playing music on hold

1 Start the Telephone.

2 Click the Menu button and then click Setup Telephone. The Telephone Properties dialog appears.

3 Click the General tab.

4 Enable Play This Wave File To The Person On Hold.

5 Click Browse, select the appropriate wave file, and then click Open.

Note

Instead of playing music to callers while they are on hold, try playing a wave file that advertises your 
company’s services.



Telephone
Announcing incoming voice calls with a sound

1 Start the Telephone.

2 Click the Menu button and then click Setup Telephone. The Telephone Properties dialog appears.

3 Click the General tab.

4 Enable Play This Wave File When A Call Comes In.

5 Click Browse, select the audio file you want to use, and then click Open.

Notes

When the Telephone is running, TalkWorks plays the wave file each time your phone rings. For example, if 
you set up TalkWorks to answer the phone after four rings, you hear this wave file four times for each incoming call.

If you do not want to be notified each time TalkWorks detects an incoming call, disable this option.
If you are using the Receive Log as your mailbox, WinFax can notify you of new messages. On the Setup 

menu in WinFax, click Receive and enable Notify on the After Receive tab of the Receive Properties dialog.



Telephone



About the TalkWorks Telephone

You can use the TalkWorks Telephone to make phone calls from your modem. You can dial out manually, use 
speed dial or retrieve the number from your WinFax phonebooks. If you have speaker phone capabilities, you can 
also use the Telephone to answer incoming calls.

You can dial directly from the Telephone by clicking the number buttons with your mouse, by clicking Dial and 
using the Dial Telephone dialog, or by keying in the number on your keyboard and clicking Dial. If you use the 
numeric keypad on your keyboard, remember that it is not the same as a phone keypad.



Starting the Telephone

Do one of the following:

From WinFax – On the TalkWorks menu, click Telephone.
From the Answering Machine – Click the Menu button and then click Start Telephone.
From the Windows Start button – Click the Windows Start button, point to Programs, then WinFax PRO, 

and then click TalkWorks Telephone. (In Windows NT 3.51, double click the TalkWorks Telephone icon in the WinFax 
PRO program group.)

From the Controller – Right click the Controller icon on the Windows taskbar and click Start Telephone on 
the menu that appears. (In Windows NT 3.51 left click the minimized Controller icon on your desktop.)



Telephone
Exiting the Telephone

Click the Menu button and then click Close.



Telephone
Dialing a phone number

1 Start the Telephone.

2 Dial the number. Do one of the following:

Dial manually – Click the number buttons on the Telephone or the number keys on your keyboard, then 
click Dial. Or, click Dial, type the number in the appropriate fields, then click Dial.

Dial using WinFax phonebooks – Click Phonebook, locate the recipient you want to call, select the 
number you want to use, and then click Dial.

Dial using a speed dial button – Click the appropriate speed dial button (if the speed dial buttons are not 
visible, click the Menu button and then enable Show Speed Dials).

Dial using speaker phone – Click Speaker and type the number on your keyboard. (Your modem must 
support speaker phone to use this method.)

Click the handset – Click the handset and type the number on your keyboard (or click the number buttons 
on the Telephone).

The Telephone dials the number.

3 Speak to the person on the other end. Do one of the following:

Pick up your handset to talk. (Use this method if your modem does not support speaker phone.)
Speak into your microphone. (Use this method if your modem supports speaker phone.)

4 To hang up, replace your phone handset or click the release (or “switch hook”) button on the Telephone.

Note

If you use the numeric keypad on your keyboard, notice the number keys are not in the same order as those
on a phone keypad.

 Related Topics



WinFax main window
Redialing a phone number

1 Start the Telephone.

2 Do one of the following:

Click Dial. The Dial Telephone dialog appears. In the Recently Dialed Numbers list, click the appropriate 
number and click Dial.

Click Redial. The Redial Options dialog appears. Select the appropriate option.

Note

To always redial a busy number, set the appropriate option on the General tab of the Telephone Properties 
dialog.

 Related Topics



Telephone
Setting up a speed dial number

1 Start the Telephone.

2 Click the Menu button and then enable Display Speed Dials. The speed dial panel appears on the Telephone.

3 Click Set Speed Dial and then click any blank speed dial button on the Telephone. The Set Speed Dial dialog 
appears.

4 In the Button Text field, type the text you want to appear on the speed dial button.

5 Do either of the following:

In the Country, Area and Number fields, type the phone number you want to dial when you click this speed 
dial button.

Click Phonebook, select the recipient from your WinFax phonebooks and click OK.
6 Click OK. The Telephone reappears with a newly-labeled speed dial button.

Notes

Keep the button text short so it fits on the speed dial button.
For detailed instructions on how to enter the phone number, click 

 at the top of the dialog and then click the appropriate field. 
To clear a speed dial, erase the entries in all fields in the Set Speed Dial dialog and click OK.

 Related Topics



Telephone
Hanging up

1 Start the Telephone.

2 During a call, click the release button to hang up and return the handset receiver to its resting position.

Note

If you are using the speaker phone, click Speaker to hang up.

 Related Topics



Telephone
Answering a voice call

1 Start the Telephone.

2 Click Speaker.

3 Speak into your microphone to begin the conversation.

Note

If the incoming call is a fax and you enabled Eavesdropping in the Receive Properties dialog, click the 
release button. WinFax places the fax in the Receive Log. To display the Receive Properties dialog, click Receive on 
the Setup menu in WinFax.



Answering Machine



About the TalkWorks Answering Machine

You can use the TalkWorks Answering Machine to check for and listen to your voice messages and to change 
greetings.

If you want to receive messages automatically with only the Answering Machine running, you can enable 
automatic receive and change the voice answering setup from the Answering Machine.



Starting the Answering Machine 

Do one of the following:

From WinFax – On the TalkWorks menu, click Answering Machine.
From the Telephone – Click the Menu button and then click Start Answering Machine.
From the Windows Start button – Click the Windows Start button, point to Programs, then WinFax PRO, 

and then click TalkWorks Answering Machine. (In Windows NT 3.51, double click the TalkWorks Answering Machine 
icon in the WinFax PRO program group.)

From the Controller – Right click the Controller icon in the Windows taskbar and click TalkWorks Answering
Machine on the menu that appears. (In Windows NT 3.51 left click the minimized Controller icon on your desktop.)



Answering Machine
Exiting the Answering Machine

Click the Menu button and then click Close.



WinFax main window
Recording a memo 

1 On the Window menu, click Receive Log. The Logs window opens to display the Receive Log folder.

2 If you set up a custom mailbox, click the mailbox folder in which you want to record the memo.

3 On the TalkWorks menu, click Memo. The Record Memo dialog appears.

4 Click the Record button. TalkWorks plays a beep to indicate that recording has started. 

5 After the beep, start recording your memo.

6 When you are finished your recording, click the Stop button.

7 Do either of the following:

If you want to listen to your recording, click the Play button.
If you want to re-record your memo, click the Record button.

8 Click Save. TalkWorks saves the memo in the active mailbox folder.

Notes

Use a memo to leave a recorded message or reminder in your mailbox for yourself.
If you record a lot of memos, add the memo button to the AudioBar. To display AudioBar properties, right 

click on the AudioBar and then click Properties.

 Related Topics



Answering Machine
Recording a memo

1 Start the Answering Machine.

2 In the mailbox drop-down list, click the mailbox in which you want to record the memo.

3 Click Memo. The Record Memo dialog appears.

4 Click the Record button. TalkWorks plays a beep to indicate that recording has started. 

5 After the beep, start recording your memo.

6 When you are finished your recording, click the Stop button.

7 Do either of the following:

If you want to listen to your recording, click the Play button.
If you want to re-record your memo, click the Record button.

8 Click Save. TalkWorks saves the memo in the active mailbox folder.

Note

Use a memo to leave a recorded message or reminder in your mailbox for yourself.

 Related Topics



Answering Machine
Recording a mailbox greeting 

1 Start the Answering Machine.

2 In the mailbox drop-down list, click the mailbox for which you want to record a greeting.

3 Click Greeting. The TalkWorks Greeting dialog appears.

4 In the Greeting section, click Custom. The Select Greeting dialog appears.

5 In the Greeting section, click Custom Greeting That I Record.

6 In the field, type a descriptive name for the greeting.

7 If desired, type the text of your greeting in the Preview section.

8 Click the Record button. TalkWorks plays a beep to indicate that recording has started. 

9 After the beep, start recording your memo.

10 When you are finished your recording, click the Stop button.

11 Do either of the following:

If you want to listen to your recording, click the Play button.
If you want to re-record your memo, click the Record button.

12 To add the greeting to the list of available greetings, click Add To Prerecorded.

13 Click OK.

 Related Topics



WinFax main window
Playing a voice message 

1 On the Window menu, click Receive Log. The Logs window opens to display the Receive Log folder.

2 If you set up multiple mailboxes, click the appropriate mailbox folder.

3 In the record list, double click the voice message you want to play.

Notes

To play all new messages in the mailbox, click the Play New Messages button on the AudioBar. 
Use the AudioBar at the bottom of the Logs window to play all new messages, rewind and fast forward 

messages, and adjust the volume.
You can also play messages from the Controller. On the Controller menu, point to New Messages and then 

click Play All New Voice Messages.

 Related Topics



Answering Machine
Playing a voice message

1 Start the Answering Machine.

2 In the mailbox drop-down list, click the mailbox containing the messages you want to play.

3 Do either of the following:

Click the Play button. 
Click the New or Old counter.

4 During playback, you can do any of the following:

To stop playback, click the Stop button.
To delete the current message, click the Delete button.
To rewind four seconds, click the Rewind button.
To fast forward four seconds, click the Fast Forward button.
To go to the next message, click the Next button.
To go to the previous message, click the Previous button.

Notes

Adjust your modem and Windows volume controls for optimum sound quality.
Check the call display screen during message playback for the date and time the message was left.
TalkWorks plays new messages first and then old messages. Unplayed voice messages are indicated by the

count in the New box. Previously played voice messages are indicated by the count in the Old box. Once a new 
message is played, it becomes an old message.

You can also play messages by clicking the New and Old counters.
The default mailbox is the Receive Log.

 Related Topics



Any touch tone phone
Calling in to change your password

1 Using a touch tone phone, dial your modem number. TalkWorks answers the call and plays a greeting.

2 During the main greeting, press the star key (*) on the phone keypad. TalkWorks detects that you are a 
mailbox owner. 

3 If there are multiple mailboxes, TalkWorks prompts you to enter your mailbox number. Enter your mailbox 
number. TalkWorks prompts you to enter your password.

4 Enter your current password and then press the number key (#). TalkWorks plays a message prompting you to
specify what you want to do. 

5 Press 7. TalkWorks prompts you to enter your new password. 

6 Enter your new password. TalkWorks prompts you to enter your new password again.

7 Enter your new password again. TalkWorks informs you that your password has been changed.

Notes

For maximum security, change your password regularly.
You must enter the numbers of your password within one second of each other. If you wait longer, TalkWorks

prompts you again to enter your password, up to three times and then hangs up.
Press the star key (*) at any time to return to the main menu of options.

 Related Topics



Any touch tone phone
Calling in for voice messages

1 Using a touch tone phone, dial your modem number. TalkWorks answers the call and plays a greeting.

2 During the main greeting, press the star key (*). TalkWorks detects that you are a mailbox owner. 

3 If there are multiple mailboxes, TalkWorks prompts you to enter your mailbox number. Enter your mailbox 
number. TalkWorks prompts you to enter your password.

4 Enter your password and then press the number key (#). TalkWorks plays a message prompting you to specify
what you want to do. 

5 Press 1. TalkWorks announces the number of messages in the mailbox and begins playing the first new 
message.

6 Do one of the following: 

To replay the message, press 1
To mark the message as old, press 2
To remove the message, press 3
To play the previous message, press 5
To play the next message, press 6

Notes

You must enter the numbers of your password within one second of each other. If you wait longer, TalkWorks
prompts you again to enter your password, up to three times and then hangs up.

Press the star key (*) at any time to return to the main menu of options.

 Related Topics



Any touch tone phone
Calling in to record your mailbox greeting

1 Using a touch tone phone, dial your modem number. TalkWorks answers the call and plays a greeting.

2 During the main greeting, press the star key (*). TalkWorks detects that you are a mailbox owner. 

3 If there are multiple mailboxes, TalkWorks prompts you to enter your mailbox number. Enter your mailbox 
number. TalkWorks prompts you to enter your password.

4 Enter your password and then press the number key (#). TalkWorks plays a message prompting you to specify
what you want to do. 

5 Press 8. TalkWorks prompts you to begin recording your message and then plays a beep.

6 Say your mailbox greeting and press the number sign (#) when you are finished.

Notes

If you are using one of the supplied TalkWorks mailbox greetings, you cannot record your mailbox greeting 
over the phone.

You must enter the numbers of your password within one second of each other. If you wait longer, TalkWorks
prompts you again to enter your password, up to three times and then hangs up.

Press the star key (*) at any time to return to the main menu of options.

 Related Topics



Any touch tone phone
Calling in to leave a message

1 Dial the fax number of the computer on which TalkWorks is installed.

2 If Automatic Receive and a call answering profile are enabled, TalkWorks answers the call when the phone 
rings and no one picks up the phone handset.

3 If prompted, press the mailbox number in which you want to leave a message. 

4 TalkWorks plays the mailbox greeting followed by a beep to indicate the beginning of recording.

5 Say your message and press the number sign (#) when you are finished. TalkWorks plays a message review 
prompt.

6 Do one of the following:

To review your message, press 1.
To re-record your message, press 2.
To quit, press the number sign (#) or hang up.

Notes

WinFax receives calls and faxes through the phone line connected to your modem. Callers use the same 
phone number to send a fax or select a mailbox and leave a voice message.

Both Automatic Receive and Voice Answering must be enabled for TalkWorks to answer voice calls. If voice 
answering is not enabled, the caller hears a high-pitched fax signal and cannot leave a voice message.

To automatically receive messages with the Automatic Receive you must be running (either as a normal or 
minimized window) one of WinFax, the Controller, or the TalkWorks Answering Machine.

Press the star key (*) at any time to return to the main menu of options.

 Related Topics



Any touch tone phone
Retrieving a fax remotely 

1 Using a touch tone phone, dial your modem number. TalkWorks answers the call and plays a greeting.

2 During the main greeting, press the star key (*). TalkWorks detects that you are a mailbox owner. 

3 If there are multiple mailboxes, TalkWorks prompts you to enter your mailbox number. Enter your mailbox 
number. TalkWorks prompts you to enter your password.

4 Enter your password and then press the number key (#). TalkWorks plays a message prompting you to specify
what you want to do. 

5 Press 1. TalkWorks plays you new voice messages and announces your new faxes.

6 While listening to a fax announcement, press 4 to retrieve it. TalkWorks prompts you to specify the destination 
fax number.

7 Follow the prompts.

Notes

You must enter the numbers of your password within one second of each other. If you wait longer, TalkWorks
prompts you again to enter your password, up to three times and then hangs up.

Press the star key (*) at any time to return to the main menu of options.

 Related Topics



WinFax main window
Deleting a voice message

1 On the Window menu, click Receive Log. The Logs window opens to display the Receive Log folder.

2 If you set up a custom mailbox, click the mailbox folder containing the message you want to delete.

3 In the record list, click the voice message you want to delete.

4 On the Edit menu, click Remove. A confirmation dialog appears.

5 Click Yes.

Note

You can also delete the selected message by clicking the Delete button on the AudioBar at the bottom of the
WinFax window.



Answering Machine
Deleting a voice message 

1 Start the Answering Machine.

2 In the mailbox drop-down list, click the mailbox folder containing the voice message you want to delete.

3 Click the Play button.

4 When you hear the message you want to delete, click the Delete button.



AudioEditor



About the TalkWorks AudioEditor

Use TalkWorks AudioEditor to record and modify greetings, voice message and wave files. Create or modify files 
to be played to callers on hold and system notification wave files. Delete background noise and stretches of 
silence or change the order of segments of the wave file. Use special effects to create an echo or fade out.



Starting AudioEditor

Do one of the following:

From WinFax – On the TalkWorks menu, click AudioEditor.
From the Windows Start button – Click the Windows Start button, point to Programs, then WinFax PRO, 

and then click TalkWorks Answering Machine. (In Windows NT 3.51, double click the TalkWorks Answering Machine 
icon in the WinFax PRO program group.)



AudioEditor
Exiting AudioEditor

On the File menu, click Exit.



AudioEditor
Specifying the scale used to display audio recordings

On the View menu, point to Scale and click the appropriate scale option.



AudioEditor
Zooming in and out in the lower audio panel

On the View menu, point to Zoom and click the appropriate zoom option.



AudioEditor
Adjusting volume controls

1 On the View menu, click Volume Controls. The Volume Control dialog appears.

2 Adjust the volume as required.



AudioEditor
Opening an audio file

1 On the File menu, click Open. The Open dialog appears.

2 Select the wave file (.WAV) you want to open and click Open. AudioEditor loads the selected file for editing.



AudioEditor
Creating an audio file

1 On the File menu, click New. AudioEditor loads a new workspace.

2 On the Player menu, click Record. The word Recording flashes on the status bar to indicate that recording is 
in progress. 

3 Say your message into your microphone.

4 On the Player menu, click Stop. Recording stops.

5 Edit the recording as required.

6 On the File menu, click Save As. The Save As dialog appears.

7 Specify the path and file name and click Save.



AudioEditor
Viewing file information

On the Options menu, click File Info. The File Info dialog appears.



AudioEditor
Setting the voice compression method

1 On the Options menu, click Tune Performance. The Tune Performance dialog appears.

2 In the Recording section, click the option that best describes your computer.

If you are using a 486 or Pentium processor, click Fast Computer. TalkWorks compresses your voice files 
while you record them and play them back.

If you are using a 486 or Pentium processor with a fast disk, click Fast Computer, Fast Disk. TalkWorks 
compresses your voice files in a buffer while you record them.

If you are using a 386 processor, click Slower Computer. TalkWorks compresses your voice files after you 
finish recording them and playing them back.

3 In the Playback section, click the option that best describes your computer.

If you are using a 486 or Pentium processor, click Faster Computer. AudioEditor compresses your voice files
while you record them and play them back.

If you are using a 386 processor, click Slower Computer. AudioEditor compresses your voice files after you 
finish recording them and playing them back.

Note

The speed of your computer determines whether AudioEditor compresses voice wave files during or after 
recording and playback. TalkWorks detects your processor speed during installation, and sets wave compression 
accordingly.



AudioEditor
Saving an audio file

On the File menu, click Save. 



AudioEditor
Recording a message

1 On the Player menu, click Record. The word Recording flashes on the status bar to indicate that recording is 
in progress. 

2 Say your message into your microphone.

3 On the Player menu, click Stop. Recording stops.

Note

A representation of the entire recording appears in the upper audio pane. The lower pane displays a 
magnified representation of a portion of the recording.



AudioEditor
Enabling record mode

1 On the Player menu, click Record. The word Recording flashes on the status bar to indicate that recording is 
in progress. 

2 Say your message into your microphone.



AudioEditor
Pausing during playback

On the Player menu, click Pause. Playing halts until you click Play on the Player menu. 



AudioEditor
Disabling record mode

On the Player menu, click Stop. Recording stops.



AudioEditor
Playing an entire recording

On the Player menu, click Play. AudioEditor plays back the message for you.



AudioEditor
Playing a segment of a recording

1 In the audio pane, click the desired start point and hold the left mouse button down.

2 Drag the mouse to highlight the segment you want to play.

3 Release the mouse button.

4 On the Player menu, click Play. AudioEditor plays back the selected segment of the message.



AudioEditor
Inserting another message in the middle of a recording

1 In the audio pane, click the desired insertion point.

2 On the Player menu, click Record. 

3 Say your message into your microphone.

4 On the Player menu, click Stop. Recording stops. AudioEditor inserts the new message into the recording at 
the specified insertion point.

Note

Edit the recording to eliminate any silences around the inserted segment.



AudioEditor
Re-recording a segment of a recording

1 In the audio pane, click the beginning of the segment you want to re-record and hold the left mouse button 
down.

2 Drag the mouse to highlight the segment you want to re-record.

3 Release the mouse button.

4 On the Player menu, click Record. The word Recording flashes on the status bar to indicate that recording is 
in progress. 

5 Say your message into the microphone.

6 On the Player menu, click Stop. Recording stops. AudioEditor overwrites the selected segment with the new 
recording.



AudioEditor
Rewinding a recording

On the Player menu, click Rewind. AudioEditor rewinds four seconds of the message.



AudioEditor
Going to the end of a recording

On the Player menu, click Go To End. AudioEditor goes to the end of the message.



AudioEditor
Adding fading effects to a recording

1 Select the segment of the audio file you want to modify.

2 On the Effects menu, point to Fade and click In or Out.



AudioEditor
Controlling the volume of a recording

1 Select the segment of the audio file you want to modify.

2 On the Effects menu, point to Volume and click the appropriate volume option.



AudioEditor
Adding an echo to a recording

1 Select the segment of the audio file you want to modify.

2 On the Effects menu, point to Echo and click the type of echo you want to add.



AudioEditor
Changing recording speed

1 Select the segment of the audio file you want to modify.

2 On the Effects menu, point to Speed and click the appropriate adjustment option.



AudioEditor
Trimming extra silence from a recording

On the Effects menu, click Trim Silence.



AudioEditor
Setting the sound quality

1 On the Options menu, click Record Settings. The Record Settings dialog appears.

2 In the Name drop-down list, click the appropriate quality option.

Note

Changes to the record settings take effect on the next new audio file you create. To change the format of the
loaded audio file, save the file and convert it.



AudioEditor
Setting the recording format

1 On the Options menu, click Record Settings. The Record Settings dialog appears.

2 In the Name drop-down list, click the quality level you want to produce for your recording.

3 In the Format drop-down list, click the appropriate option.



AudioEditor
Setting recording attributes

1 On the Options menu, click Record Settings. The Record Settings dialog appears.

2 In the Attributes drop-down list, click the appropriate option.



AudioEditor
Undoing the last action

On the Edit menu, click Undo.



AudioEditor
Cutting a segment out of an audio file

1 Select the segment you want to remove in the upper audio pane.

2 On the Edit menu, click Cut.



AudioEditor
Copying a segment of an audio file

1 Select the segment you want to copy in the upper audio pane.

2 On the Edit menu, click Copy.



AudioEditor
Pasting a segment from the Clipboard into an audio file

1 In the upper audio pane, position the cursor at the desired insertion point.

2 On the Edit menu, click Paste. The contents of the Clipboard appear inserted at the cursor position.



AudioEditor
Pasting another audio file into the loaded audio file

1 In the upper audio pane, position the cursor at the desired insertion point.

2 On the Edit menu, click Paste From. The Open dialog appears.

3 Select the wave file you want to insert and click Open. The contents of the selected wave file appear at the 
cursor position.



AudioEditor
Deleting a segment from an audio file

1 In the upper audio pane, select the segment you want to delete.

2 On the Edit menu, click Delete.



AudioEditor
Selecting the entire audio file

On the Edit menu, click Select All.



AudioEditor
Viewing and hiding the toolbar 

On the View menu, enable Toolbar.

Note

To hide the toolbar, disable Toolbar on the View menu.



AudioEditor
Viewing and hiding the status bar

On the View menu, enable Status Bar.

Note

To hide the status bar, disable Status Bar on the View menu.
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 About dialog (VCRES)

VCAPP_IDD_ABOUT



Displays information about TalkWorks, including the version number, and the name of the person to whom this software is licensed.



Answering Machine (VCRES)



Click this to display the Answering Machine menu. 

Use the commands on the menu to switch TalkWorks call answering profiles, modify mailbox settings, change your modem settings,
change receive settings, start the Telephone, start WinFax, and to view the TalkWorks online help.



Displays the number of new messages in the active mailbox. Click this counter to play all new messages in the active mailbox.



Displays the number of old messages in the active mailbox. Old messages are messages you have already reviewed, but not 
deleted from the mailbox. Click this counter to play all old messages in the active mailbox.



Adjusts the volume at which recorded messages are played back. If adjusting the volume slide control does not generate the 
desired results, you may need to adjust the volume settings in Windows as well.



Click this to record a new greeting for the active mailbox.



Click this to record a voice memo in the active mailbox.



Displays information about the current state and activity of the Answering Machine. 

If automatic reception is enabled (click the Menu button and then click Automatic Receive) an icon appears on the right side of the 
call information area. If the Answering Machine is not accepting calls, this icon does not appear.

During message playback, the call information area displays details about the message including the message type (new or old), 
length, and the date and time it was received.



Click this to play all messages in the active mailbox. The Answering Machine plays the new messages first, then the old messages.



Click this to stop message playback.



Click this to delete the current message.



Click this to rewind to the start of the previous message.



Click this to rewind the message four seconds.



Click this to fast forward the message four seconds.



Click this to fast forward to the start of the next message.



Rewinds or forwards the message to a specific portion of the message, based on the location of the slide control. For example, if 
you position the slide control halfway between the leftmost setting and the rightmost setting on the slide control, the Answering 
Machine fast forwards to the middle of the message and then starts playing the last half of the message.

The rewind and forward buttons on the Answering Machine allow you to move to the start of a message, the end of a message, or to
rewind or fast forward four seconds of the recording. Use this slide control when you need to locate a segment of the message more
precisely. 

Typically, you might use this feature if a caller leaves you a detailed message including their phone number and you want to locate 
the phone number in the recording so you can write it down. To do this, move the slide control to the part of the message where you 
think it is recorded, listen for a moment to identify if this is the correct location, and repeat the process until you find the correct 
segment of the message.



Adjusts the message playback speed. 

Typically, you might increase the playback speed, if you want to quickly listen to all messages in your mailbox so that you can easily 
identify the urgent messages. To return to “normal” speed, position the slide control at the center position.



Displays the active mailbox. To switch to another mailbox, click it in the drop-down list.



To learn more about the settings in this dialog, click this button, then click the setting you want to learn about.



Click this to minimize the Answering Machine.



Click this to exit the Answering Machine.



Answering Machine Menu (VCRES)
VCAPP_IDC_TAM_MENU



Click this to move the Answering Machine to another position on the screen. Drag the mouse pointer to the new position and release
the mouse button.



Click this to minimize the Answering Machine. 



Click this to start WinFax.



Click this to start the TalkWorks Telephone.



Click this to switch profiles, modify mailbox settings, or change device options.



Click this to modify receive settings.



Click this to modify your modem settings.



Click this to enable or disable automatic reception.



Click this to exit the Answering Machine.



Click this to view the TalkWorks online help.



Click this to view information about TalkWorks, including the version number, and the name of the person to whom this software is 
licensed.



AudioBar buttons



Plays all new voice messages in the selected mailbox.



Plays the selected voice message in the selected mailbox.



Pauses message playback or recording.



Stops message playback or recording.



Fast forwards the current voice message four seconds.



Rewinds the current voice message four seconds.



Rewinds to the start of the previous voice message in the mailbox.



Fast forwards to the start of the next voice message in the mailbox.



Records a voice memo in the selected mailbox. 



Starts the TalkWorks AudioEditor.



Adjusts the volume at which voice messages are played back. If adjusting the volume slide control does not generate the desired 
results, you may need to adjust the volume settings in Windows as well.



Rewinds or forwards the message to a specific portion of the message, based on the location of the slide control. For example, if 
you position the slide control halfway between the leftmost setting and the rightmost setting on the slide control, the Answering 
Machine fast forwards to the middle of the message and then starts playing the last half of the message.

The rewind and forward buttons on the Answering Machine allow you to move to the start of a message, the end of a message, or to
rewind or fast forward four seconds of the recording. Use this slide control when you need to locate a segment of the message more
precisely. 

Typically, you might use this feature if a caller leaves you a detailed message including their phone number and you want to locate 
the phone number in the recording so you can write it down. To do this, move the slide control to the part of the message where you 
think it is recorded, listen for a moment to identify if this is the correct location, and repeat the process until you find the correct 
segment of the message.



Adjusts the message playback speed. 

Typically, you might increase the playback speed, if you want to quickly listen to all messages in your mailbox so that you can easily 
identify the urgent messages. To return to “normal” speed, position the slide control at the center position.



Deletes the selected voice message in the mailbox.



Click this to customize the AudioBar.



AudioBar Properties (VCRES)



 Enable this option to display the Previous Message button on the AudioBar.



Enable this option to display the Memo button on the AudioBar.



Enable this option to display the Delete button on the AudioBar.



Enable this option to display the Rewind button on the AudioBar.



Enable this option to display the Forward button on the AudioBar.



Enable this option to display the Edit Message button on the AudioBar. Use the Edit Message button to open the selected message 
in the TalkWorks AudioEditor.



Enable this option to display the Position slide control on the AudioBar.



Enable this option to display the Volume slide control on the AudioBar.



Enable this option to display the Speed slide control on the AudioBar.



Common Components



Displays text and/or an icon that helps to describe the functionality available in this dialog. 

For more information about a specific setting, click the What’s This button  and then click the appropriate setting.



Groups related settings together. 

For more information about a specific setting, click the What’s This button  and then click the appropriate setting.



Displays information about the item currently selected in the window. You can view item information, item thumbnails or the actual 
item, depending on the Display command enabled on the View menu.



Convert Wave File dialog (VCRES)

VCAPP_IDD_CONVERT_WAVE_FILE



Displays a description of the audio file.



Displays the name of the audio file.



Dial Telephone dialog (VCRES)

VCAPP_IDD_PHONE_DIALCONFIRM



Type the country code you dial when calling the recipient. TalkWorks uses the country code to determine how to dial long distance 
numbers. The country code is bolded in the examples below.

North American number: 1-987-555-1234

International number: 011-301-555-6789



Type the area code that you dial when calling the recipient. The area code is bolded in the examples below.

North American number: 1-987-555-1234

International number: 011-301-555-6789

If the number in this field matches the area code identifier on an outgoing call, TalkWorks does not dial the area code. If the number 
in this field does not match the area code on the outgoing call, TalkWorks recognizes it as a long distance call and dials the area 
code.



Type the recipient’s local phone number. The local phone number is bolded in the examples below.

North American number: 1-987-555-1234

International number: 011-301-555-6789



Click this to select a phone number from any phonebook available in WinFax.



Displays a list of phone numbers you recently dialed using the Telephone. To dial a number in the list, select the number and click 
Dial.



Enable this option to automatically redial the phone number if the line is busy.



File Info dialog (VCRES)

VCAPP_IDD_FILEINFO



Displays the length of the recording, in seconds.



Displays the size of this file.



Displays the date when this file was recorded.



Displays the date when this file was recorded.



File Info dialog (Wave Info - Audio Editor) (VCRES)

VCAPP_IDD_WAVEINFO



Displays the compression method used for this audio message.



Displays the sampling rate for this audio message. Higher sampling rates produce audio files that are closer to the original sound.



Displays the sampling size for this audio file. 



Displays the appropriate setting. 



Displays the date when this audio message was recorded.



Displays the time when this audio message was recorded.



Phonebook dialog (VCRES)

VCAPP_IDD_PHONEBOOK



Lists all phonebooks available in WinFax. Click a phonebook to view the records it contains.



Lists all recipients in the selected phonebook. Click a record to display additional information about it. 



Depending on how you set up your recipient records, you may specify a voice number, a cellular number, a primary fax number, and
an alternate fax number for recipients. TalkWorks displays the phone numbers entered in the recipient record for the selected 
recipient, if any, beside the voice, cellular, primary fax, alternate fax options in this section of the dialog.

You can dial any of these numbers from the Telephone. Click this to use the voice number from the selected recipient record. 



Depending on how you set up your recipient records, you may specify a voice number, a cellular number, a primary fax number, and
an alternate fax number for recipients. TalkWorks displays the phone numbers entered in the recipient record for the selected 
recipient, if any, beside the voice, cellular, primary fax, alternate fax options in this section of the dialog.

You can dial any of these numbers from the Telephone. Click this to use the cellular number from the selected recipient record. 



Depending on how you set up your recipient records, you may specify a voice number, a cellular number, a primary fax number, and
an alternate fax number for recipients. TalkWorks displays the phone numbers entered in the recipient record for the selected 
recipient, if any, beside the voice, cellular, primary fax, alternate fax options in this section of the dialog.

You can dial any of these numbers from the Telephone. Click this to use the primary fax number from the selected recipient record. 



Depending on how you set up your recipient records, you may specify a voice number, a cellular number, a primary fax number, and
an alternate fax number for recipients. TalkWorks displays the phone numbers entered in the recipient record for the selected 
recipient, if any, beside the voice, cellular, primary fax, alternate fax options in this section of the dialog.

You can dial any of these numbers from the Telephone. Click this to use the alternate fax number from the selected recipient record. 



Click this to dial the selected phone number.



Click this to create a new recipient record in the selected phonebook.



Click this to delete the selected recipient record from the phonebook.



Click this to modify the selected recipient record. Typically, you may need to modify the recipient record to include the correct voice 
or cellular phone number.



Click this to search the selected phonebook for a specific recipient based on the search criteria you specify.



Click this to redisplay all records in the selected phonebook after a search.



Please Wait ... Converting ... dialog (VCRES)

VCUT_IDD_PROGRESS



TalkWorks is converting the audio file to a format that is compatible with your modem. Please wait momentarily while TalkWorks 
completes the conversion.



Displays the percentage of the conversion that is complete.



New Document dialog (FOD) (VCRES)

TW Properties-Mailbox tab (click Add button)

VCAPP_IDD_DLG_FOD_DOC_PROPERTIES



Type a description to identify this Fax On Demand document.



Lists all fax-fax image files (.FXS) included in this Fax On Demand document. The fax image files appear in the order in which they 
will be faxed. To add a file, click Add.

A Fax On Demand document contains one fax image file (.FXS) for each page in the document you want to make available on your 
Fax On Demand system. For example, if you to create a Fax On Demand document for a four-page marketing brochure, your Fax 
On Demand document includes four fax image files (.FXS)—one for each page in the document. To convert your document to fax 
image format, print it to the WinFax printer driver and save it as an attachment file.



Displays a thumbnail image of the file selected in the Document Files list. Use the images to ensure that your fax pages are listed in 
the order you want them faxed.



Click this to select the fax image files included in this Fax On Demand document.

A Fax On Demand document contains one fax image file (.FXS) for each page in the document you want to make available on your 
Fax On Demand system. For example, if you to create a Fax On Demand document for a four-page marketing brochure, your Fax 
On Demand document includes four fax image files (.FXS)—one for each page in the document. To convert your document to fax 
image format, print it to the WinFax printer driver and save it as an attachment file.



Click this to remove the selected fax image file from the Document Files list.



Moves the selected file in the Document Files list up one position. Move the fax image files into the order you want them faxed.



Moves the selected file in the Document Files list up one position. Move the fax image files into the order you want them faxed.



Receive Properties (Answer tab) (VCRES)
VCAPP_IDD_SETUP_VOICE_OPTION



Type the minimum message length (in seconds) in this field. All messages shorter than this length are not recorded. This prevents 
TalkWorks from recording messages if the caller hangs up without saying anything.



Type the maximum message length (in seconds) in this field. Use this field to maximize the number of messages your mailbox can 
hold.

The capacity of your mailbox depends on the amount of hard disk space you have available for voice messages. A one minute voice
message file takes up approximately 250K of hard disk space.



Select the compression level you want to use for voice messages. If quality is more important than the size of voice messages, click 
Best Quality. If disk space or file size is most important, click Best Compression.



Enable this option if you want TalkWorks to stamp the time at which messages are left in 24-hour format. 
If you disable this option, TalkWorks stamp the time messages were left using the 12-hour clock with the appropriate a.m. or p.m. 
label.



Enable this option if you want TalkWorks to notify you when you have new voice messages by flashing the Scroll Lock light on your 
keyboard.



Record Memo dialog (VCRES)

VCAPP_IDD_RECORDFILE



Displays information about the voice memo.



Click this to play the voice memo.



Click this to stop playing or recording the voice memo.



Click this to start recording the voice memo.



Click this to import the audio file (.WAV format) you want to save as a voice memo in the selected mailbox.



Click this send the voice memo to another person via email. TalkWorks attaches the voice message file (.WAV format) to the email 
message.



Redial Options dialog (VCRES)

VCAPP_IDD_PHONE_REDIAL



Click this to redial the last number you dialed with the Telephone.



Click this to redial the last number you dialed with the Telephone and to keep redialing until the someone answers the call.



Click this to set up automatic redial options for all calls you make with the Telephone.



Schedule Greeting dialog (VCRES)

VCAPP_IDD_MAILBOX_SCHEDULE 



Set the time at which you want to start playing the main mailbox greeting.



Set the time at which you want to stop playing the main mailbox greeting.



Enable this to play the main mailbox greeting on Sundays.



Enable this to play the main mailbox greeting on Mondays.



Enable this to play the main mailbox greeting on Tuesdays.



Enable this to play the main mailbox greeting on Wednesdays.



Enable this to play the main mailbox greeting on Thursdays.



Enable this to play the main mailbox greeting on Fridays.



Enable this to play the main mailbox greeting on Saturdays.



Enable this to use the same scheduling options for all mailboxes in this profile.



Select Greeting dialog (VCRES)

VCAPP_IDD_WIZ_SELECT_GREETING 



Click this to answer calls to this mailbox without playing a greeting.



Click this if you want to use a custom recording as your mailbox greeting. You can record a custom greeting now or you can import 
any audio file (.WAV format) you recorded previously and use it as your custom greeting.



Type a description for your custom greeting.



Click this to import an audio file (.WAV) format you recorded previously and use it as your custom greeting.



Click this to add the custom greeting (that is, the greeting you recorded or imported) to the Prerecorded list of greetings. You can 
then use this greeting for other mailboxes.



Click this to use one of the prerecorded greetings included with TalkWorks. 

TalkWorks includes the Cover Your Voice collection of humorous and business greetings. If you did not install the Cover Your Voice 
collection, or you deleted it, run the Setup program again to re-install it.



Select the prerecorded greeting you want to use for this mailbox.



Click this to remove a greeting from the Prerecorded list. This deletes the greeting from the list and removes the corresponding 
greeting file from your computer.



Displays a description of the selected greeting. If the selected greeting is a prerecorded TalkWorks greeting, a condensed script for 
the message appears in this area. If you are recording a custom greeting of your own, you can type the text of the greeting here so 
you can read it as you record.



Click this to play the greeting.



Click this to stop playing or recording the greeting.



Click this to start recording the greeting.



Set Speed Dial dialog (VCRES)

VCAPP_IDD_PHONE_SETSPEEDDIAL



Type a description for this speed dial button. The description appears as text on the speed dial button. For example, use the 
recipient’s name or company name.



Type the country code that you dial when calling the recipient. TalkWorks uses the country code to determine how to dial long 
distance numbers. The country code is bolded in the examples below.

North American number: 1-987-555-1234

International number: 011-301-555-6789



Type the area code that you dial when calling the recipient. The area code is bolded in the examples below.

North American number: 1-987-555-1234

International number: 011-301-555-6789

If the number in this field matches the area code identifier on an outgoing call, TalkWorks does not dial the area code. If the number 
in this field does not match the area code on the outgoing call, TalkWorks recognizes it as a long distance call and dials the area 
code.



Type the recipient’s local phone number. The local phone number is bolded in the examples below.

North American number: 1-987-555-1234

International number: 011-301-555-6789



Click this to select a phone number from any phonebook in WinFax. 



Telephone (VCRES)

VCAPP_IDD_TELEPHONE



Click this to display the Telephone menu. 

Use the commands on the menu to modify dialing settings (including location settings and credit card options), modem settings, 
display/hide the Speed Dial panel on the Telephone, start the Answering Machine, start WinFax, and to view the TalkWorks online 
help.



Click the handset to start a call. To hang up, click the release button in the Telephone cradle. The release button is visible only when 
the handset is off the cradle. 



Displays the current time. 

When you place a voice call, information about the status of the call appears in the call information area.



Click this to dial a phone number. If you have already entered the phone number when you click this button, the Telephone starts to 
dial. Otherwise, the Dial dialog appears for you to specify the phone number of the person you want to call.



Click this to redial the last number you dialed with the Telephone.



Click this to disconnect the current call. This clears the connection and re-opens the line so you can begin a new call.



Click this to pick up an incoming call when you hear the call waiting tone. 

This option is available only if you subscribe to a call waiting service from your local phone company and your voice modem 
supports call waiting.



Click this to put the caller on hold. If you use the hold feature, consider using a call holding recording. You can set up a call holding 
message in the Telephone Properties dialog (click the Menu button and then click Setup Telephone). You may want to use your “on-
hold” recording to convey your marketing message, information about your company, or to play music while the caller waits.

This option is only available if your voice modem supports speaker phone capabilities.



If you answer a fax call with the Telephone, click this button to switch to fax mode so that you can receive the fax. 



Click this to select a number to dial from any phonebook in WinFax.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the call information 
area. When you are finished entering the phone number, click Dial to begin dialing the phone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the call information 
area. When you are finished entering the phone number, click Dial to begin dialing the phone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the call information 
area. When you are finished entering the phone number, click Dial to begin dialing the phone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the call information 
area. When you are finished entering the phone number, click Dial to begin dialing the phone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the call information 
area. When you are finished entering the phone number, click Dial to begin dialing the phone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the call information 
area. When you are finished entering the phone number, click Dial to begin dialing the phone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the call information 
area. When you are finished entering the phone number, click Dial to begin dialing the phone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the call information 
area. When you are finished entering the phone number, click Dial to begin dialing the phone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the call information 
area. When you are finished entering the phone number, click Dial to begin dialing the phone number.



Click the numbers on the number pad to specify the number you want to dial. Each number you click appears in the call information 
area. When you are finished entering the phone number, click Dial to begin dialing the phone number.



Click this to dial the number key (#).



Click this to dial the star key (*).



Adjusts the incoming volume. To adjust the outgoing volume, hold down the Shift key and drag the volume slider to the appropriate 
level. 



Click this to use the speaker phone to place or answer a voice call. When you are using the speaker phone, the indicator on this 
button appears red.

This option is only available if your voice modem supports speaker phone capabilities.



Click this to block out sound at your end of the call. When this option is enabled, the indicator on this button appears red.

This option is only available if your voice modem supports speaker phone capabilities.



To learn more about the settings in this dialog, click this button, then click the setting you want to learn about.



Click this to dial the number associated with this speed dial button.



Click this to set up a speed dial, then click the speed dial button you want to set up.



Click this to minimize the Telephone.



Click this to exit the Telephone.



Telephone Menu (VCRES)

VCAPP_IDC_PHONE_MENU



Click this to move the Telephone to another position on the screen. Drag the mouse pointer to the new position and release the 
mouse.



Click this to minimize the Telephone.



Click this to start the Answering Machine.



Click this to change options for the Telephone.



Click this to change the dialing instructions used by the Telephone. Use this command to set up calling locations and credit cards.



Click this to display the speed dial button panel on the Telephone.



Click this to exit the Telephone.



Telephone Properties (VCRES)

VCAPP_IDD_PHONE_PROPPAGE1



In the drop-down list, click the modem you want to use to place or answer voice calls using the speaker phone. The list displays all 
modems set up for use with TalkWorks.



Enable this option if you want TalkWorks to wait for a dial tone before starting to dial.



Enable this option if you want TalkWorks to detect and inform you of a busy signal. 



Enable this if you want TalkWorks to announce incoming calls by playing an audio file. Typically, you might want to use this feature 
so that you can monitor incoming calls and distinguish between the Telephone “ringing” and the ringing from your phone set (on 
your desk). 

TalkWorks plays this audio file whenever the Telephone is running and there is an incoming call.



Click Browse to select the audio file you want to play to announce incoming calls.

TalkWorks plays this audio file whenever the Telephone is running and there is an incoming call.



Click Browse to select the audio file you want to play to announce incoming calls.

TalkWorks plays this audio file whenever the Telephone is running and there is an incoming call.



Enable this to play an audio file when you put a caller on hold. You may want to use your “on-hold” recording to convey your 
marketing message, information about your company, or to play music while the caller waits.

This hold option is only available if your voice modem supports speaker phone capabilities.



Click Browse to select the audio file you want to play when you put a caller on hold.

This hold option is only available if your voice modem supports speaker phone capabilities.



Click Browse to select the audio file you want to play when you put a caller on hold.

This hold option is only available if your voice modem supports speaker phone capabilities.



Click this if you want TalkWorks to try to redial a busy phone number for a specific length of time.



Type the number of minutes you want TalkWorks to try to redial a busy phone number.



Type the number of seconds you want TalkWorks to try to redial a busy phone number.



Click this if you want TalkWorks to try to redial a busy phone number a specific number of times.



Type the number of times you want TalkWorks to try to redial a busy phone number.



Type the number of seconds you want TalkWorks to wait before redialing a busy phone number.



Test TalkWorks dialog? (VCRES)

VCAPP_IDD_WIZ_MESSAGE 



Enable this if you do not want to see this message again.



Tune Performance (VCRES)
VCAPP_IDD_PERFTUNE



Click this if you are using a 486 or Pentium computer. Voice files are compressed while you record them.



Click this if you are using a 486 or Pentium computer. Voice files are compressed in a buffer while you record them.



Click this if you are using a 386 computer. Voice files are compressed after you finish recording them.



Click this if you are using a 486 or Pentium computer. Voice files are compressed while you play them back.



Click this if you are using a 386 computer. Voice files are compressed after you finish playing them back.



Volume control (VCRES)

VCAPP_IDD_VOLUMECONTROL



Adjust the slide control to the appropriate volume. If adjusting the volume slide control does not generate the desired results, you 
may need to adjust the volume settings in Windows as well.



Wizard - Available Mailboxes panel (VCRES)

VCAPP_IDD_WIZ_MAILBOXES_PROPERTIES 



Available Mailboxes 

Use this dialog to select the mailboxes you want to include in your profile. You can include up to 100 mailboxes in 
a TalkWorks profile. To include a mailbox, select it in the mailbox list and then assign a mailbox number for the 
mailbox in the Selected Mailbox Number drop-down list. 

This dialog contains the following settings:

Mailbox list – Lists all existing mailboxes. By default, this list contains the default TalkWorks mailbox—the 
Receive Log. If you have already set up mailboxes, either for another profile, or from the Mailboxes tab on the 
TalkWorks Properties dialog (on the TalkWorks menu in WinFax, click Setup), they appear in this list. Beside each 
mailbox name, TalkWorks displays the mailbox number or the word “Disabled”. All mailboxes with assigned 
mailbox numbers are included in this profile; all disabled mailboxes are not included.

Add button – Click this to create a new mailbox that you can include in your profile.

Disable button – Click this to remove the selected mailbox from the current profile. This does not delete the 
mailbox; it changes the entry in the Selected Mailbox Number drop-down list to Disabled. If you disable a mailbox 
and you recorded a custom mailbox menu, you may need to re-record the mailbox menu to remove the reference 
to the disabled mailbox.

Properties button – Click this to modify the settings for the selected mailbox. When you modify a mailbox, 
TalkWorks updates all profiles that use the mailbox.

Selected Mailbox Number – In the drop-down list, click the mailbox number you want to assign to this mailbox. If 
you do not want to use the selected mailbox in this profile, click Disabled in the drop-down list.

Number Of Digits In Mailbox Number – Specify the number of digits you want to use for all the mailboxes in this 
profile. You can use between one and three digits for mailbox numbers.



Wizard - Call Management panel (VCRES)

VCAPP_IDD_WIZ_SINGLE_OR_MULTIPLE_BMP



Call Management

Use this dialog to specify whether you want to create a single mailbox or multiple mailboxes. 

This dialog contains the following settings:

Direct All Calls To A Single Mailbox – Click this option if you want to use TalkWorks as a simple answering 
machine.

Have The Caller Select One Of The Multiple Mailboxes I Create – Click this option if you want to create a 
mailbox system that includes two or more mailboxes. 



Wizard - Cover Page Design dialog (VCRES)

VCAPP_IDD_WIZ_COVER_PAGE_DESIGN



Type the path and name of the logo file that you want to use on the cover page that is faxed with each Fax On Demand document 
the caller requests. You must use a .FXS format logo file.



Click this to select the logo file from your computer drives and folders. 



Click this to add text from a file to the Fax On Demand cover page. 

Use this option if you need to change the text that appears on the Fax On Demand cover page regularly. To change the cover page 
text, edit the text file and save it with the same path and file name. The next time you send a fax with the cover page, TalkWorks 
inserts the contents of the updated text file. 



Type the path and name of the text file containing the text you want to appear on the Fax On Demand cover page.



Click this to select the file you want to use from your computer’s drives and folders.



Click this to add text you type in the text area or import from a file to the Fax On Demand cover page.



Type the text that you want to appear on the Fax On Demand cover page. 



Click this to select the file you want to import from your computer’s drives and folders.



Wizard - Cover Page panel (VCRES)

VCAPP_IDD_WIZ_COVER_PAGE



Cover Page

Use this dialog to add a cover page to each Fax On Demand document a caller requests. 

This dialog contains the following settings:

Send A Cover Page When Faxing Documents From This Mailbox check box – Enable this option if you want 
to include a cover page with each document you fax to callers.

Type A Subject ... – Type the subject that you want to appear on the fax cover page.

Advanced button – Click this if you want to customize the cover page to include your logo or additional text.



Wizard - Documents panel (VCRES)

VCAPP_IDD_WIZ_FOD_EDIT_DOCLIST



Documents

Use this dialog to specify the documents you want to include in this Fax On Demand mailbox. 

A Fax On Demand document contains one fax image file (.FXS) for each page in the document you want to make 
available on your Fax On Demand system. For example, if you to create a Fax On Demand document for a four-
page marketing brochure, your Fax On Demand document includes four fax image files (.FXS)—one for each 
page in the document. To convert your document to fax image format, print it to the WinFax printer driver and save
it as an attachment file. For more information about creating an attachment, click here .

To set up a Fax On Demand document, click Add, select the appropriate fax image files and click OK. Then assign
a document number to the Fax On Demand document in the document number drop-down list. Repeat this 
process for each document you want to add to your Fax On Demand mailbox.

This dialog contains the following settings:

Document list – Lists all documents that callers can request to have faxed to them.

Add button – Click this to add a document to this Fax On Demand mailbox. 

Remove button – Click this to remove the selected document from this Fax On Demand mailbox.

Properties button – Click this to add, remove, or change the order of fax pages in the selected document.

Document number – In the drop-down list, click the number you want to assign to the selected document.

Number Of Digits In Document Number – Specify the number of digits you want to use for all the documents in 
this mailbox. You can use between one and three digits for document numbers.



Wizard - Greeting panel (VCRES)

VCAPP_IDD_WIZ_SELECT_PRIMARY_TYPE



Greeting

Use this dialog to select the greeting callers will hear when they access this mailbox. You can select a 
prerecorded greeting from the Cover Your Voice collection, record your own greeting, or you can import any audio 
file (.WAV format) stored on your computer and use it as a greeting. You can use a single greeting at all times, or 
schedule a main and alternate greeting. For example, you can use a standard greeting during office hours and a 
second greeting after office hours to tell callers when you will be available.

By default, the greeting “No One Is Available” is selected. This greeting plays the message “No one is available to
take your call right now. Please leave a message and we’ll call you back shortly.”

If you do not want to play a greeting for this mailbox, click None in the Greeting drop-down list.

Using a Prerecorded Greeting

All prerecorded greetings appear in the drop-down list in the Greeting section. To listen to a greeting, click it in the 
drop-down list and then click the Play button. To stop recording, click the Stop button.

In the drop-down list, click the prerecorded you want to use.

Recording Your Own Greeting Now

To record a custom greeting now, click Custom.

Importing a Previously Recorded Greeting

You can use any audio file (.WAV format) on your computer as a greeting. Typically, you will need to import 
greetings that you recorded professionally or that you recorded ahead of time in the AudioEditor.

To import a greeting, click Custom.



Wizard - Introduction Panel (VCRES)

VCAPP_IDD_WIZ_INTRO_ANSWERING



Introduction

The TalkWorks Mailbox wizard guides you step-by-step through the process of creating a TalkWorks profile. A 
TalkWorks profile is a collection of settings and mailboxes that define how your call answering system works. You 
can create and save as many profiles as you need.

Before you start to create your profile, we strongly recommend you spend some time planning your profile first. 
Planning may improve the usability of your call answering system. For more information about planning your 
profile, click here .

Use this dialog to name your profile.
This dialog contains the following settings:
Profile Name – Type a description for this profile to help you identify it in the future.
Create A New Profile – Click this option to create a new profile.

Based On Existing Profile – Click this option to base your new profile on an existing profile. Click the profile you 
want to use as a template in the drop-down list. When you choose this option, TalkWorks copies the settings from 
the selected profile as a starting point for your new template. As you use the wizard, the settings from the selected
profile will appear as default settings that you can change or customize as required.



Wizard - Mailbox Menu panel (VCRES)

VCAPP_IDD_WIZ_MBOX_MENU_BMP



Mailbox Menu

Use this dialog to set up a Mailbox menu. The Mailbox menu identifies the mailboxes in your mailbox system so 
that callers can access the appropriate mailbox. Callers hear this menu after the Main greeting but before the 
Mailbox greeting.

If your callers know the mailbox numbers (for example, you have your mailbox number printed on your business 
card), TalkWorks can play a general prompt which prompts callers to select a mailbox. If you do not think that 
callers will know the mailbox numbers, you should record a menu which identifies the available mailboxes and 
prompts callers to select from one of them (for example, for sales, press 1;for service, press 2; and so on). 

This dialog contains the following settings:

Do Not Prompt The Caller – Click this option if you do not want to use a mailbox menu for your mailbox system.

Play Only The TalkWorks Mailbox Prompt – Click this if callers know the mailbox numbers. After the main 
greeting, TalkWorks plays the message “Please enter the mailbox number.”

Play A Custom Mailbox – Click this to use a custom mailbox menu. You can either record the menu by using the 
Play, Stop, and Record buttons, or you can import a prerecorded menu by clicking the Import button. If you are 
recording the menu, you can use the text in the display area as a guide.



Wizard - Mailbox Properties dialog (General tab) (VCRES)

VCAPP_IDD_WIZ_ASSIGN_BOXNAME



Mailbox Properties 

Use this dialog to specify the mailbox name and type.

Mailbox Name – Type the name of the mailbox.

Mailbox Type – In the drop-down list, click the appropriate mailbox type. A brief message describing the selected 
type appears below the drop-down list.

Fax Back Options – If you are creating or modifying a Fax On Demand mailbox, you can also select how callers 
retrieve faxes in the Fax Back Options section. If you send documents to callers during the same call, the caller 
must pay for any applicable long distance charges. If you send documents to a number specified by the caller, you
may have to pay for long distance charges. You can also prompt the caller to select one of these options.



Wizard - Main Greeting panel (VCRES)

VCAPP_IDD_WIZ_MAIN_GREETING_BMP 



Main Greeting 

Use this dialog to set up a main greeting for your call answering system.

The main greeting is the message that callers hear when TalkWorks first answers the phone. You can use one of 
many prerecorded greetings in the Cover Your Voice collection, record your own greeting, or you can import any 
audio file (.WAV format) stored on your computer and use it as a greeting. You can use the same main greeting all
the time, or you can create an alternate greeting and schedule when you want to use them.

By default, the prerecorded “TalkWorks” greeting is selected. This greeting plays the message “This call is being 
answered by TalkWorks.”

Using a Prerecorded Greeting

All prerecorded greetings appear in the drop-down list in the Greeting section. To listen to a greeting, click it in the 
drop-down list and then click the Play button. To stop recording, click the Stop button.

In the drop-down list, click the prerecorded you want to use.

Recording Your Own Greeting Now

To record a custom greeting now, click Custom.

Importing a Previously Recorded Greeting

You can use any audio file (.WAV format) on your computer as a greeting. Typically, you will need to import 
greetings that you recorded professionally or that you recorded ahead of time in the AudioEditor.

To import a greeting, click Custom.



Wizard - Menu panel
VCAPP_IDD_WIZ_FOD_RECORD_GREETING (VCRES)



Document Menu

Use this dialog to set up a document menu to assist callers in selecting the Fax On Demand documents they want
faxed to them. Record or listen to the document menu that callers will use to select the information they want to 
retrieve from this Fax On Demand mailbox.

If your callers know the document numbers, TalkWorks can play a general prompt which asks callers to select a 
document. If you do not think that callers will know the document numbers, you should record a menu which 
identifies the documents in this mailbox.

This dialog contains the following settings:

Play Only The TalkWorks Document Prompt – Click this if callers know the document numbers. When a caller 
selects this mailbox, TalkWorks plays the message “Please enter the number of the document you wish to have 
faxed to you”.

Play A Custom Document Menu That I Record – Click this to use a custom document menu for this mailbox. 
You can either record the menu by using the Play, Stop, and Record buttons, or import a prerecorded menu by 
clicking the Import button. If you are recording the menu, you can use the text in the display area as a guide.



Wizard - New Mailbox Summary panel (VCRES)
VCAPP_IDD_WIZ_NEW_BOX_COMMIT



Mailbox Summary

This panel summarizes all the settings you have chosen for this mailbox. Review the list to make sure that all the 
settings are correct. To create the mailbox, click Create.

If you want to change a setting, click Back until you see the information that you want to change. Make the 
appropriate changes, then click Next until you return to this panel. To create the mailbox, click Create.



Wizard - Profile Summary panel (VCRES)

VCAPP_IDD_WIZ_SUMMARY_MAILBOX



Profile Summary

This panel summarizes all the settings you have chosen for this profile. Review the list to make sure that all the 
settings are correct. To create the profile, click Finish.

If you want to change a setting, click Back until you see the information that you want to change. Make the 
appropriate changes, then click Next until you return to this panel. To create the profile, click Finish.



Wizard - Remote Access & Traffic Logging panel (VCRES)

 VCAPP_IDD_WIZ_REMOTE_ACCESS



Remote Access and Traffic Logging

Use this dialog to set up remote mailbox access and traffic logging.

Message Retrieval

Using remote access, you can review the messages in this mailbox and change the mailbox greeting. If you want 
to be able to access this mailbox from a remote touch tone phone, enable Allow Callers To Retrieve Voice 
Messages And Faxes From This Mailbox and type a password in the Password field. The password must contain 
numbers only and be between two and eight digits.

This option is only available for Voice Message, Announcement Only, Fax Only, and Fax On Demand mailboxes. 

Traffic Logging

Use this option to track all calls to a mailbox. Each time a caller accesses the mailbox, TalkWorks adds tracking 
information about the call to a log file. By default, TalkWorks logs mailbox traffic the TALKWORKS.TXT file in the 
DATA subfolder of the WinFax installation folder. To use another name, type the path and file name in the File 
Name field.

By default, TalkWorks includes the date and time of the call, the mailbox name, the caller name and the caller 
phone/fax number. However, you can customize the information tracked by TalkWorks by specifying WinFax 
variables (for a list, click here ) in the Entry Text field. 

To view the log file, click View Log on the Mailboxes tab of the TalkWorks Properties dialog (on the TalkWorks 
menu in WinFax, click Setup). Alternately, open the log file in any text editor or word processor.



Wizard - Schedule Greeting dialog (VCRES)

VCAPP_IDD_WIZ_SCHEDULE



Schedule Greeting

Use this dialog to schedule when the main and alternate greetings are used in your call answering system. 
TalkWorks will play the main greeting during the hours and on the days you specify, and play the alternate 
greeting at all other times.

To schedule the main greeting, specify the start and end times for the greeting, and enable the days on which you 
want TalkWorks to play the greeting.



Wizard - Select Mailbox panel (VCRES)

VCAPP_IDD_WIZ_SINGLE_SEL_MAILBOX



Select Mailbox

Use this dialog to select the mailbox you want to use as your basic answering machine. You can use any existing 
mailbox or you can create a new mailbox now. In the list, click the mailbox you want to use in your profile. 

This dialog contains the following settings:

Mailbox list – Lists all existing mailboxes. By default, this list contains the default TalkWorks mailbox—the 
Receive Log. If you have already set up mailboxes, either for another profile or from the Mailboxes tab on the 
TalkWorks Properties dialog, they appear in the list.

Add button – Click this to create a new mailbox now.

Properties button – Click this button to modify the selected mailbox.



OK & Cancel Buttons



Closes this dialog box, saves and implements any changes you have made and executes the necessary action (if any). Typically 
this button is named “OK”, however in some places the title may be more descriptive (for example, “Dial”).



Closes this dialog box without saving any changes you have made. 



TalkWorks Properties dialog (Devices tab) (VCRES)

(TalkWorks only)
VCAPP_IDD_SETUP_VOICE_DEVICE 



Select the main modem you want to use to playing back messages. Use this line to retrieve messages remotely.

TalkWorks uses this information to determine the format for storing your voice messages.



Adjusts the volume of your outgoing greeting. If adjusting the volume slide control does not generate the desired results, you may 
need to adjust the volume settings in Windows as well.



Select the device you want to use to listen to your voice messages and greetings.



Adjusts the volume at which voice messages and greetings are played back. If adjusting the volume slide control does not generate 
the desired results, you may need to adjust the volume settings in Windows as well.



Select the device you want to use to record memos and greetings.



If you selected Dial Phone Number as the playback or recording device, specify the phone number TalkWorks should call.



Click this to optimize recording and playback in TalkWorks.



TalkWorks Properties dialog (Mailboxes tab) (VCRES)

(TalkWorks only)
VCAPP_IDD_SETUP_MAILBOX



Lists all existing mailboxes, including all mailboxes used by all existing profiles.



Click this to create a new mailbox. You can create a Voice Message mailbox, an Announcement Only mailbox, a Fax On Demand 
mailbox, a Fax Only mailbox, or a Data Only mailbox. You can create as many mailboxes as you need, and you can use up to 100 
mailboxes in any profile.



Click this to delete the selected mailbox.



Click this to change the options for the selected mailbox. If this mailbox is included in a profile, TalkWorks updates the mailbox 
information for that profile as well.



Click this to view the call tracking log for the selected mailbox. If you did not enable the call tracking option for the selected mailbox, 
this button appears grayed.



TalkWorks Properties dialog (Profiles tab) (VCRES)

(TalkWorks only)
VCAPP_IDD_SETUP_SCRIPT



Lists all existing TalkWorks call answering profiles.

A profile is a collection of mailboxes and settings that determine how your TalkWorks call answering system works. You can create 
and save as many profiles as you need, and you can use them to quickly change your call answering setup.

If you installed TalkWorks for a first time, Setup creates a default profile that sets TalkWorks up to function as a basic answering 
machine. This single mailbox profile is set up to play the default TalkWorks greeting (“This call is being answered by TalkWorks”) 
and store incoming voice messages and faxes in the Receive Log folder. The default profile is ready to use—all you need to do is 
turn it on. 

If you upgraded from a previous version of TalkWorks, Setup saves your pre-existing call answering system as the default profile. 
This profile is named “My TalkWorks Profile”.

To run a simulation of the profile, click the profile and then click Test.



Click this to create a new TalkWorks profile. You can create and save as many profiles as you need. 



Click this to delete the selected profile.



Click this to change the options for the selected profile. For example, you might want to modify a profile to change your main 
greeting, schedule the greetings, add or remove mailboxes, and so on.



Click this to test the selected profile. TalkWorks starts the TalkWorks Simulator—a “telephone” you can use to simulate an incoming 
call.



Select the profile you want to use on your primary modem. The drop-down list contains all existing profiles, plus the Fax Only profile.
Use the Fax Only profile if you want to disable TalkWorks and only use this modem for faxing.

If the modem does not have voice capabilities, the Fax Only profile is automatically selected.

TalkWorks will only answer phone calls using the active profile when automatic reception is enabled.



Select the profile you want to use on your second modem. The drop-down list contains all existing profiles, plus the Fax Only profile.
Use the Fax Only profile if you want to disable TalkWorks and only use this modem for faxing.

If the modem does not have voice capabilities, the Fax Only profile is automatically selected.

To use this profile, automatic reception must also be enabled for this modem.

TalkWorks will only answer phone calls using the active profile when automatic reception is enabled.



Receive Properties (Voice tab) (VCRES)

(TalkWorks only)
VCAPP_IDD_SETUP_VOICE



Select the phone line for which you want to specify receive options.



Enable this option to use toll saving features.

Use this option to identify if you have new messages when you call in from an outside line. If there are no new messages, your 
phone will ring two more times than it normally would if TalkWorks were answering the call, giving you time to hang up.

The toll saver feature only detects new messages in the Receive Log. If you set up a multiple mailbox system, you cannot use the 
toll saver feature.



Enable this option to use call screening features.

Use this option to hear callers on your modem speaker as they leave voice messages. You can then decide whether to pick up the 
call or let TalkWorks continue to record the messages.

You can only screen your calls if your hardware supports call screening.



Adjust the slide control to the appropriate volume for call screening.



Enable this option to use eavesdropping features with TalkWorks.

When this option is enabled, WinFax detects and takes over an incoming fax call, even if you pick up the handset first.



Adjust the slide control to change the sensitivity to sound.

TalkWorks stops recording when it detects silence. If TalkWorks is interpreting speech pauses as the end of the message, decrease 
the sensitivity of silence detection. 




